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Foreword

There are so many things to consider in the process of collecting, organising, preserving, 
and sharing your family story. This book, Opening the doors to Family Tree Maker 

is an excellent guide for helping you know how to correctly and effectively enter the 
information you have about your family story into Family Tree Maker. John Donaldson is 
an excellent guide, and was instrumental in helping me as I was introduced to Family Tree 
Maker 10 years ago.

That’s when I first became acquainted with John and came to rely regularly on his 
expertise and guidance along with a few other carefully selected advisors. In the years 
that followed, Family Tree Maker has changed a great deal and John has been involved 
every step of the way. His expertise has helped countless others, as John has been teaching, 
writing and helping people with Family Tree Maker in Australia and abroad for more than 
15 years. 

Family Tree Maker is a powerful but easy-to-use program for helping you to discover, 
preserve, and share your family’s heritage. It is available for Windows and Mac computers 
and John is versed and familiar with both. In this book, John uses his experience and 
friendly style to teach, guide, and help you learn where and how to enter your research and 
information into Family Tree Maker. Best wishes in this exciting journey.

Duff Wilson
Family Tree Maker 
Ancestry.com
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Introduction
This book is a follow on from my first book on Family Tree Maker So you are totally 
new to Family Tree Maker (second edition). That book as the title implies was to assist 
very new users to Family Tree Maker (whether Windows or Mac) to load and start the 
program and get some basic output. The book was designed to be about as simple and non- 
threatening as it could be. If it was a book on learning to fly, it covered starting the engine, 
taking off, doing a circuit and landing safely.

Many new users have reported that they found the book helpful and I hope to do a third 
edition when the next versions of Family Tree Maker are released. Family Tree Maker 
2016 (Windows) and Family Tree Maker 4 (Mac).

Note that Ancestry.com has renamed Family Tree Maker Mac3 to Family Tree Maker 3  
(or FTM3). This is because they make it available in the Apple iStore and by definition all 
products in the store are ‘Mac’ so you can’t have Mac in the title.

This book, Opening the doors to Family Tree Maker has been designed to take the user 
to a higher level and is part one of a two-part series.

Opening the doors is designed to explain how you correctly enter your various data 
and research into Family Tree Maker, whether it be Windows or Mac. My experience 
shows that many users are unsure as how to correctly add information into the program. A 
long time ago a person told me that if you ‘lie to your database (with incorrect information 
entry) it lies right back to you with incorrect reports and charts’. Well family Tree Maker is 
nothing more that a genealogical database so data entry is very important.

My reference to ‘doors’ is to convey the sense that there are various doors for entering 
data, each appropriate to the data being entered. You enter names in a different location to 
where you enter dates or places or media etc.

The second part of this two-part series, working title, Exiting the doors to Family Tree 
Maker will focus on output, reports, charts, books, online trees, smart phones and tablets 
as well as how to use Family Tree Maker with other applications such as MS Word, MS 
Excel, image editing programs, etc.

Both books have been designed to be small and compact and something that is easy to 
read and understand and above all applying the understanding to enjoy the program.

John Donaldson 
March 2015
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Opening the doors into Family Tree Maker

Family Tree Maker is essentially a database program. It is in fact a relational database 
consisting of a number of tables with the data connected by internal links or pointers. 
Sometimes I like to think of Family Tree Maker as a large building with a number of doors 
to enter and a number of doors to exit.

In this book, I am going to have a look at all the ‘entry doors’. By entry doors I 
am referring where you enter Family Tree Maker by adding data like: names, dates, 
places, media, notes and sources etc. Many of these entry doors are located in the People 
Workspace, but of course you have the Places, Sources and Media Workspaces as well. So 
let’s start and where most people begin by using the ‘name door’ or entering names into 
the program.

I am planning a second book that will talk about the exit doors of Family Tree Maker. 
The ones used to generate reports, charts, books and to produce files to be used in other 
applications like MS Word, MS Excel, etc.

Family Tree 
Maker 2014

Family Tree 
Maker 3
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Chapter one
Door number one—the name door 

Everyone has a name (except perhaps Javert Prisoner 24601 in Les Miserables). Names 
are usually the first thing that you enter into Family Tree Maker. Usually names consist 

of a surname or family name and first or forenames, often called Christian names. So I am 
going to commence by looking at how names are handled in Family Tree Maker.

Entering names
In the western world we normally write names as forename (given name) surname e.g. 
John Smith. This is how Family Tree Maker expects them and this is how most people 
enter names. Note than when entering names for females, you use the maiden or unmarried 
name e.g. Jane Smith.

Alternative names
Often in our research we come across a person who is known in the various sources with 
different or alternative names, and more commonly spelling differences.

Family Tree Maker allows you to record as many alternative names as you wish. To 
do this, go to the People>Person view and add a new name fact. Now enter the alternative 
name. Now Family Tree Maker allows you to define which one is the Preferred name fact 
and marks it as Preferred.

This will be the name fact that is displayed in reports and charts etc. Now, later 
research may clarify the person’s name, and if that is the case, you can go back into the 
Person view and delete the alternative name. The quickest way to do this? Select the fact 
then right click and select Delete.

Also known as (AKA) Nickname
You can also add a nickname or ‘AKA’ for a person. Again, as above, go to the Person 
view and add a new fact ‘Also Known As’. Now enter the Nickname.

Note that Family Tree Maker will also list this fact as Preferred. The Also Known As, 
or AKA fact can be used in report or charts etc. to display the name and/or the AKA. Don’t 
forget to add a source and/or a note about the derivation and use of the AKA.

Way back when Family Tree Maker did not handle AKAs very well, I got into the 
habit of entering AKAs along with the name, e.g. Herman (Buck) Donaldson. I have 
continued with this method, which to me has the advantage of one less fact to control and 
both the name and the nickname show up in all reports and charts without me having to 
deliberatively select the AKA. Others use quotes. It doesn’t matter what you use, just be 
consistent in its use throughout your file. Note that these will show as potential name errors 
by Family Tree Maker unless you turn off these warnings in the Tool>Options dialogue.
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Titles in Name fact
You can have a title (such as ‘Dr or Major’). Titles are not entered into the name field but 
are entered as a Title fact one of Family Tree Maker’s standard Fact names. You can then 
choose to us the title fact as part of the name in charts and reports etc.

Text in quotes (nicknames) in the Name fact:
You can have the name in quotes copied to the Also Known As field or have it left in 

the Name field.

Name suffixes
Name suffixes such as Jr (Junior), Sr (Senior) and III (the Third) are often used in 
identifying ancestors with similar names. To enter a suffix go to the Person view and enter 
the suffix without a comma e.g. Elspit Donaldson Jr.

Do not enter name suffixes such as Jr or III, in the Title field. This field is 
reserved for appellations such as Rev, Dr or Major. Suffixes entered in the Title 
fields will be printed in front of the name e.g. ‘Jr Elspit Donaldson’. This may 
not be what you want.

The name edit dialogue
This is a great but often overlooked dialogue. If you click in the name field you will reveal a 
pencil icon. Clicking on this icon reveals a name edit box. This is also where you can add a 
suffix and also adjust names. You can add suffixes and also correct names that Family Tree 
Maker is having problems with resolving. You can also add umlauts or diacritical marks.

How to create umlauts, diacritical marks or accents in names
You may have noticed in the examples that I have used so far that many of the names have 
accents or diacritical marks.

These are common in many languages such as French, German, Spanish, Portuguese 
and many others. Often these are also referred to as symbols and way, way back before 
Windows; the early computers were programmed with these symbols that were referred to 
as ASCII codes. You can see a list of them on this link.

www.ascii-code.com

Edit Name dialogue (Win)	         Symbol table (Win)
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Note the slightly different arrangement of the 
diacritical table between Windows and Mac.

ASCII codes are still there, but nowadays 
we tend to use them from the Insert Symbol in 
MS Word and now you can do it in Family Tree 
Maker. All Windows or Family Tree Maker is 
doing is translating from a symbol table to the 
ASCII code, so you don’t have to remember the 
ASCII codes.

Edit Name dialogue and symbol table (Mac)

To include a symbol in a name
Simply click on the edit pencil to the right of 
the name. This opens an edit box that includes a link to the diacritical list (insert Symbol). 
This opens the symbol table.

Tip: This symbol table is also available in Notes in the Person view.

Name editing options
The following table describes the options in the Edit Name dialog box:

Option Description

Auto Fix Auto Fix appears only when there is an error in the name.
Family Tree Maker will attempt to determine the intent of the name and make 
adjustments accordingly. For example, if a nickname is included in the name in 
quotation marks, Family Tree Maker will remove the nick- name from the name and 
put it in a new ‘Also Known As’ fact.

Ignore Ignore appears only when there is an error in the name.
You can use Ignore to have Family Tree Maker leave the name as it is. Ignored names 
display as they are entered in the Name field without a warning icon.

Name status Notes whether the name is in a format understood by Family Tree Maker. If there are 
any problems, they are explained here.

Given 
names

The first and middle names of the person, as Family Tree Maker understands them. 
You can edit the names as needed.

Surname The last or family name of the person, as determined by Family Tree Maker. You can 
edit the surname as needed.

Suffix Jr., Esq., Dr., or any other title included in the name. You can edit the suffix as 
needed.
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Multi-word surnames (sometimes called ‘dit’ names)
As a general rule, Family Tree Maker 2008/2014/Mac1/2/3 assumes the last word entered 
in the name field is the individual’s surname. However, it also recognises many common 
surname prefixes e.g. ‘van den Dungan’.

Here is a list of recognised prefixes in Family Tree Maker:
o’, d’, van, von, ver, st., saint, der, de, la, del, della, las, te, ten, ter, le, du, des, da, dos, 

le, detto, di, dit, du, in’t, lo, ‘t, te, tan, uit, den, uyt, vulgo
The significance of these prefixes is that the name will usually be correctly sorted, e.g., 

François Le Smith will show in the index as Le Smith, François.

See also http://genealogy.about.com/b/2010/07/08/understanding-dit-names.htm, or 
put ‘dit names’ into Google.

Hyphenated surnames
This can happen when women use both their maiden and surnames together e.g. Hilary 
Rodham-Clinton. You can record the surname as an alternative fact or in the Also Known 
As (AKA) fact.

Duplicate surnames
This can occur when a female ancestor whose last name at birth is the same as her 
husband’s e.g. cousins marrying. To avoid confusion, use the personal note field to also 
record the details.

My method of uniquely identifying people in my file
You won’t see this one in the books on Family Tree Maker (unless it is a book that I have 
written). Many years ago I was getting confused with ancestors with the same name. This 
was before Family Tree Maker did a double sort of the index by alpha then by date of 
birth. So to identify people with the same name and make everyone in my file unique, I 
used a number in square brackets between the forenames and the surname, e.g. Elizabeth 
[04] Marris. To my joy, the index also sorted them by my unique ID number.

Note the use of a leading zero (0) in the number. This stops the 10 being incorrectly 
sorted. Also, again to my great joy, the 
numbers do not interfere with Ancestry 
searches. 

The Ancestry search algorithms ignore 
the number. Thank you Ancestry. The 
advantage to me is everyone is unique. So 
if I am sharing research with someone, I 
can refer to Elizabeth [04] Marris, confident 
that she is the only person in my file with 
that name and I don’t have to list any other 
parameters, e.g. like date of birth or parents 
to positively identify her.

The other little side benefit is that 
as my Ancestry Member Tree (AMT) is 
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public, I often see other researchers who have used my data in their trees, merging the data 
complete with the square brackets. I don’t mind as I have a public AMT, but it is amusing 
to see how your data are used.

Using slashes
In some cases an individual entered into Family Tree Maker may have two surnames, 
e.g. ‘Aquirre Chanquin’. To ensure that multi-word surnames are not indexed incorrectly, 
you can insert a backslash (\) before and after the surname. e.g. Maria Graciela \Aguirre 
Chanquin\.

In the index it will show correctly as ‘Aguirre Chanquin, Maria Graciela’. Note: Once 
entered, the backslashes do not appear. They are merely used to initially assign names 
appropriately as given names or surnames. They are called ‘delimiters’.

Note: This also works in earlier versions of Family Tree Maker. You see the slashes in 
the Family View but you don’t see them in reports or charts.

Surname variations
As you research you will inevitably discover that surnames in the same line can change 
over the generations. Often this can be associated with a migration event, especially where 
a European name is anglicised or perhaps shortened. This also of course means that you 
have to search for names in many variations, but that is the thrill of the chase. As noted 
above, you can have as many name facts as you wish as well as the AKA field and I would 
also strongly suggest that you utilise the notes and research note capability of Family Tree 
Maker.

Unknown names
Unfortunately you cannot always find the name or part of a name in your research. There 
are numerous ways to handle it but whatever strategy you adopt, be consistent. I use ?? for 
an unknown forename and ‘Unknown’ for an unknown surname e.g.

?? Unknown,
?? Smith,
John Unknown

Being consistent lets me use the much beloved Custom Report to keep track of where I 
have work to do. Others use a number of spaces or underlines, or a combination e.g. ‘?’. It 
doesn’t matter what you do, but find a method you like and stay with it. Be consistent and 
the Custom Report will always work correctly!!

Non-breaking space
This was in fact my very first tip in my first column in March 1998 but it is worth 
reminding people. Consider the example. I have just used for the compound name ‘Aquirre 
Chanquin’.

Instead of using the (\) I could use the non-breaking space Alt+0160.
Note this must be entered from the numeric keypad.
Type ‘Aquirre<Alt+0160>Chanquin’ (no quotes). That is hold down the Alt key and 

from the numeric keypad type in 0160. ‘Aquirre Chanquin’ will be displayed but the 
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space between the names is actually the non-breaking space that is read as an ‘invisible’ 
character so Family Tree Maker thinks that it is one name. Note in the example, I have use 
the carats <> and quotation marks ‘ ’ simply to make the example clear. In doing it for real 
you don’t enter them.

I used to be very keen on this method over slashes but be aware that whilst the name 
looks and sorts correctly in Family Tree Maker it may not be recognised correctly by 
Ancestry in searching or leaf hints. I would suggest that if you are going to use the non- 
breaking space technique that you also check that it is recognised correctly by online 
search indexes.

Sorting children and blended families
You can sort children in birth order by 
simply clicking on the sort children 
button (arrows) in the Tree view or go 
to Tools>Sort All Children By Birth.

Once you have sorted children 
you can also invoke Blended Families (picket 
fence button) to show all issue where there has 
been multiple marriages. Note that as both controls work on the same data (children) you 
can’t use both together. I suggest sort children first then show blended families where 
appropriate.

Order of names in different languages
This is not strictly a Family Tree Maker issue, but be aware that the order of first names 
and surnames can vary. Consider:

Spanish: John <father’s surname> <mother’s surname> Juan López Rodríguez. In 
Spanish, that is the first surname.

Enter under López. Portuguese: John <mother’s surname> <father’s surname> João 
Rodrigues Lopes. In Portuguese, it is the last surname. 
Enter under Lopes.

So you need to be careful how you enter the 
surname, which may in fact not be the last name as 
it is in this country. I am indebted to GUM member 
Peter Matthews who many years ago sent me this 
excellent link as to all the various ‘rules’ applying in 
various countries.
http://genealogy.wikia.com/wiki/Family_name 

Convert (case) names
This is a useful routine on the Tools menu that will convert names from UPPER to Mixed 
case and vice versa. This can be particularly useful if you have your names as ‘Smith’ and 
you merge a file with names as ‘SMITH’.

Simply run the Convert Names routine selecting the format you want. I always use the 
form ‘Smith’ as it then lets me display names as Smith or SMITH in reports and charts.
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Using names in reports and charts—options
Having set up your names you can include some of the various facts that you have 
included with your names. Note that you can have surnames all caps and for this reason I 
always enter my names as mixed case so I can use this option when I want it. If you choose 
to enter all your surnames upper case and/or use the convert name tool, you don’t have this 
option.

I also acknowledge that there are many different ways to display names. For example, 
some people use upper case surnames for their direct lines and use mixed case for the rest. 
It is your database, your family and your choice.

The index (introduction)
As you add names, Family Tree Maker automatically creates an index of 
these names which is available in the People Workspace Tree view. The 
index is the primary navigation tool to move around your file. It is a multi-
door tool.

Home person
Just to the right of the people count is a small house icon similar to one of those houses 
that you had when you played Monopoly. This designates the home person. In Family Tree 
Maker you can designate a home person.

To set a home person simply right click on the person’s name in the Index or use the 
person menu. In this shot I have nominated Kennedy John F as the home person and you 
can see the home icon next to his name.

Usually I have myself as the home 
person as in the top right hand panel where 
you have the focus person showing (and 
a photo if you choose) you always see the 
relationship of that person to the home 
person. If I am the home person it tells me 
instantly what the relationship is and helps 
me understand what I am entering. 

But on some occasions I change the 
home person especially if I am working 
on someone else’s file, or am entering data 
for some line in the file and want to see the 
relationship to (say) the eldest in the line. 
My point is that you can be flexible with 
this to suit your particular needs.

Home person is shown by a ‘house’ icon beside  
their name

Take me home!!
If you click on this home icon on the index top line from wherever you are in the People 
Family view, you will immediately be taken to the Home person. You also can see the 
Home person on a file in the Plan view in the summary block. If you would like to get a 
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little more information on this feature, have a look at the FTM Blog:
http://blogs.ancestry.com/ancestr/2011/01/24/family-tree-maker-home-person

Show additional index data
If you click on the icon immediately next to the home icon you get the opportunity to 
expand the index to show additional data, e.g. birth, marriage or death dates in the index. 
If you have these additional data items displayed, you can drag the columns to show all the 
information much like you do in Excel or Outlook.

Sorting the index
I noted that the default in the index is a sort alphabetically by family then given name. But 
there are many other ways to sort the index. Immediately below the first line is the Sort Box.

Two-level index sort
Users of earlier version of Family Tree Maker before version 2011 may 
have noticed in using versions 2011 and above that when opening the 
Family View, the index takes a little longer to build and you see the 
rotating wheel for a moment. What is going on?

Well what it is doing is making a second sort pass through the index.
The first pass is sorting alphabetically by family name, but then it goes back and 

looks at the given names and dates of birth and sorts them by birth date. So, if you have 
as I have, 10 persons named Marris, John, when I see the list of them in the index, I 
immediately see them in age chronological order. This was a very nice little enhancement 
and is in the Mac version as well.

Displaying alternative names in the index
Family Tree Maker lets you determine how names are displayed in the index. You have the 
option to include titles, Also Known As (AKA) names and also married names for females.

To do this you need to go to the Tools menu and click on Options. Then you click on 
the Names/Dates/Places tab.

The options are:
�� Use AKA if available as a middle name: If an alias is included in quotes after the 

middle name, both the given name and AKA (Also Known As) are listed in the index.
�� Use AKA if available as an additional entry: If an alias or nickname has been 

entered for an individual, both the 
given name and AKA are listed in 
the index.

�� Use titles if available: If a name 
includes a title, both the given 
name and title with name are listed 
in the index.

�� Use married names for females: 
Lists married females by their 
married name instead of their 
maiden name.



Opening the doors to Family Tree Maker |  page 17

Finding individuals in the index
Working down the index you will see a Find box with a couple of arrows next to it. You 
can use this to find someone in the index. If the index is sorted family then given name it 
is best to type in the family name, then a comma, then the given name e.g. Smith, Robert. 
The search is progressive, and depending on the size of your file, you will get to the name 
within a few letters.

If you have the index sorted given name then family name, then it is best to start with 
the given name e.g. Robert, Smith. The arrows let you also progress to the next or previous 
match. I suggest a little practice, but it works very well. This also is useful if you are 
searching for a first name.

Number of people in your file
The top line of the index shows the number of people in your file. In this example it shows 
116 people.

Follow the ‘yellow brick road’ home
No matter where you are in a pedigree view in the 
People Workspace, if you see a yellow arrow in the 
children’s area, clicking on that will always take you 
to the next yellow arrow, which will eventually take 
you back to the home person.

Very helpful if you get lost. So as Dorothy and 
the Munchkins discovered, all you have to do is to 
‘follow the yellow brick road’. ♫ ♫

Show additional index data
If you click on the icon immediately next to the home icon (vertical arrow in Fig 2) you get 
the opportunity to expand the index to show additional data, e.g. birth, marriage or death 
dates in the index. If you have these additional data items displayed, you can drag the 
columns to show all the information much like you do in Excel or Outlook.

Hiding the index
Note that next to the show additional data icon there 
is another icon that lets you hide (minimise) the index 
pane and so leave more screen real estate for other 
views in the Family view. This can be useful if you 
are working with a small screen e.g. on a laptop. As 
the People Workspace in Family Tree Maker is very 
configurable, this can sometimes be useful. To reopen 
the index pane simply click on the same icon.
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Sorting the index
I noted that the default in the index is a sort alphabetically by family then given name. But 
there are many other ways to sort the index.

Immediately below the first line is the Sort box. This lets you sort the index in different 
ways.

The options in the index are quite clever when it comes to the three date sort options. It 
groups the dates in ranges so that the display is easier to display.

Filtering the index
This function has actually been in Family Tree Maker even before the new format version 
2008 was released. It was actually in versions 2005, 2006 and 16 yet, when I talk about it 
in workshops, I often get a blank look, as if it was totally new. So what is it all about?

As your tree gets bigger you can have thousands, or hundreds of thousands of people 
listed in the index. It can become cumbersome to scroll through them if you want to work 
on say a branch of your tree, or people from the same location, or people born on, before, 
after, or between certain dates, or were buried in a certain cemetery. This is where the filter 
in the index comes in.

To invoke a filter, click on the filter button in the index. This opens the filter, which 
should by now be well known to most users of Family Tree Maker.

Option Description

Name Lets you search the Name list for people to include in the filter.

Name list Lists all of the people in your tree. You can select people from the list to 
determine who will be included in the filter.

Include Moves the selected person into the Filter list.

Include All Moves every name in the Name list to the Filter list. This is helpful if you want 
to exclude people from the list rather than include them. After all the names are 
included, you can use the Exclude and Filter Out options to remove the names 
you don’t want in the filtered list.

Ancestors Moves all of the direct ancestors of the selected person into the Filter list. The 
Ancestors option allows you to include all ancestor parents and spouses, or only 
preferred parents and spouses as well as all ancestors’ descendants (children/
grandchildren, etc.) and specify the number of generations from the selected 
person to include.

Descendants Moves all of the descendants of the selected person into the Filter list.

Filter In Opens the Filter Individuals by Criteria dialog box where you can establish criteria 
for filtering people into the Filter list.

Exclude Removes the selected person from the Filter list.

Exclude All Removes all people from the Filter list.

Filter Out Opens the Filter Individuals by Criteria dialog box where you can establish criteria 
for filtering people out of the Filter list.

Filter list The list of persons who will be included in the index when the filter is active.
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Let me give you an example. I want to work only on people who were born in Kirton-
in-Lindsey, so instead of having a visible index of over 7000 people, I just want to show 
the people in the geographic area that I am working on. This allows me to focus on the area 
or group that I am considering.

So I Filter In as follows:
In this instance, I have used Vital facts, for Birth Place contains Kirton-in-Lindsey with 

Match any value and clicked OK. This gives me 1162 people in this example who match 
my filter criteria.

Filter In 				    and    Filter Results

This is much more convenient to work with if I am looking at a received file of people 
from that area, or I am going to the records office there, etc. Note the Apply Filter check 
box is now checked indicating that you have an index filter applied.

Unchecking the box closes the filtered view and returns you to the full index. Also 
Family Tree Maker remembers your last filter so you can reapply it by simply checking the 
filter check box again.

The index filter is the same filter that is used in custom reports and to export selected 
people from your file. It is also used to select people in reports and charts, so learn it once 
and you have learned it all through Family Tree Maker. It is worth understanding, as it is 
one of the core capabilities of any database to be able to extract and set or sub-set of data. 
Also, there are some great examples on pages 53/54 in Beyond the basics 2012.

Mousing over the index
One of the nice little tricks is to mouse 
over a name in the index by pausing 
or hovering the mouse pointer over a 
name.

This provides you key details 
of the person. You can see that it gives me the birth date and place, marriage date, place 
(and partner name) and death date and place. Very useful. (You can do the same thing by 
mousing on any name in the pedigree view in the family view).

Bookmarks
We all know what bookmarks are in books. They identify a particular page in a book. 
Similarly the idea is extended to Bookmarks for your favourite websites in your browser. 
Well Family Tree Maker has bookmarks in the index. So why would you use it?

I use bookmarks for a range of things. You may want to bookmark (tag) say 
grandparents, or someone in a line that you are working on. I have found them particularly 
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useful if I am troubleshooting a tree where 
there is a problem with a relationship and to 
understand what the problem is, you need to 
jump back and forward between people to find 
the error. By bookmarking the suspect people 
lets you quickly focus on the problem and 
hopefully fix it.

To apply a bookmark is simply right click 
on the name in the index (or the person’s box in 
the pedigree view) or use the Person Menu and 
apply a bookmark. This will cause a little book 
icon to appear against that person’s name in the index.

To remove a bookmark simply right click on a bookmarked person and use the Delete 
Bookmark (or again use the Person Menu).

You can view the people that you have bookmarked by clicking on the Bookmark 
button on the index. Of course what you are seeing is an index filter for bookmarks that 
Family Tree Maker creates and yes, you can use bookmarks to group individuals.

History
So finally we get to the bottom of the index—History. History allows you to see the last 
200 entries that you have made and this is the important bit, with the most recently edited 
person at the top of the list! This list can be very useful especially if you haven’t used 
Family Tree Maker for a while, or you have been working on various files. History lets you 
answer that vital question, ‘what was I 
working on last week that I want to go 
back to’?

But there is a little bit more to 
History.

Earlier I mentioned how useful 
mousing is with names to quickly 
show additional data. Well mousing in 
the History list gives you information 
on what you did and when.

Printing or sharing an index
Simply use the Index of Individuals report in the Publish Workspace.

Also, like every other report, it can be shared (Share Button) as a PDF file, RTF and if 
you want to use it in a spreadsheet or external database like MS Access, as a CSV file.

Fixing mistakes
People do make data entry or merging mistakes when entering data into Family Tree 
Maker. Follows are a couple of techniques to help you correct these mistakes. There are 
also the excellent Data Errors and Find Duplicates reports but I will cover those in the 
second book. Incidentally, when you add names to Family Tree Maker it does check in the 
background to see if you are entering a duplicate and warns you if it detects a duplicate.
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A play file
Those who have attended any GUM Family Tree Maker workshops over the last three 
years or so will know that we strongly advocate using an old file or creating a small one 
and use it as a play file. The idea is that you experiment with a new idea or technique in 
your play file before committing to your main file. A bit like a golfer having a few practice 
swings before hitting the shot. I have one based on the Flintstone characters which I find 
useful. I even get the odd shaky leaf hint when I put the tree online.

Deleting or detaching?
This is one that often trips new users up. It goes something like this. ‘Help, I have added 
the wrong spouse, children etc. to a person. Do I have to delete them all and start again?’

I have found after a number of painful experiences, that unless you are at the very 
top or the very bottom of a family line, that deleting often causes very unpleasant and 
unexpected consequences!!!!

Family Tree Maker has a much better system called attach and detach. Now a small hint.
When you detach someone they exist in the index but may not be anywhere else. My fail 
safe method is to get a pencil and paper (really) and draw the relationship as it is then 
another little diagram of how I want it to be before I begin the attach/detach exercise. So 
this is how you do it.

Detaching incorrect relationships using Family Tree Maker
1.	 Under the People Workspace, select the 

individual you want to detach from a 
relationship from the index on the left.

2.	 From the top of the window, click the Person 
menu and select Attach/Detach Person, then 
Detach Selected Person.

3.	 In the Detach window, select the individual(s) 
you want to detach this person from, and then 
click OK.

4.	 The individual is now detached from these	 
relationships.

Reattaching individuals using Family Tree Maker
1.	 Under the People Workspace, select the individual you want to reattach family to 

from the index on the left.
2.	 From the top of the window, click the Person menu and select Attach/Detach 

Person, then select Attach Father, Mother, Spouse, or Child.
3.	 Scroll through the list of individuals and find the person you want to attach. Select 

their name, and click OK.
4.	 In the Attach window, choose the existing or new family you want to attach this 

person to and click OK.
5.	 The individual will now show with the correct family listed.
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Duplicates
When you are entering people, Family Tree 
Maker checks your data entry and warns 
you if it thinks you are entering a possible 
duplicate. You have the option of saying 
‘Yes’ and it will merge the new person with 
the existing, or ‘No’ and it the entry of the 
new person proceeds.

Summary
An understanding of how names are used in Family Tree Maker together with your 
knowledge of your family can help in ensuring that you enter names correctly and that you 
can then use in your research.
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Chapter two
Door number two—the date door

Apart from names, dates are 
probably the next most 

common items that you enter. 
Family Tree Maker considers 
everything that you enter into your 
file as a fact. So a name, a date are 
all facts. So what are dates?

Now most of you reading this 
would answer that dates are shown 
on a calendar. So that gets down to 
what is a calendar? If you do a bit of research, you will discover that there are many types 
of calendars, and they all don’t agree. If for example you go to this link, www.fourmilab.
ch/documents/calendar you will find that you can convert to and from many calendars, 
including Gregorian, Julian, Hebrew and Islamic.

Gregorian calendar
Most of us now use the Gregorian calendar and its history goes something like this:

The Gregorian calendar was proclaimed by Pope Gregory XIII and took effect in most 
Catholic states in 1582, in which October 4, 1582 of the Julian calendar was followed 
by October 15 in the new calendar, correcting for the accumulated discrepancy between 
the Julian calendar and the equinox as of that date. When comparing historical dates, it’s 
important to note that the Gregorian calendar used universally today in Western countries 
and in international commerce, was adopted at different times by different countries. Britain 
and her colonies (including what is now the United States), did not switch to the Gregorian 
calendar until 1752, when Wednesday 2nd September in the Julian calendar dawned as 
Thursday the 14th in the Gregorian.

Now carefully note this date 1752. This is the default in Family Tree Maker but it can 
be altered as many countries adopted the Gregorian calendar at different times. Here are 
some examples

Greece 1924, Hungary 1587, Japan 1783, Netherlands 1583, China 1912 or 1929,
Germany 1610.
See: www.webexhibits.org/calendars/year-countries.html
The point of all of this? Early dates can be affected depending on the country and when 

it changed its calendar and 1752 may not be correct for (say) China. Unfortunately Family 
Tree Maker only lets you use one cut-over date and I have yet to see a genealogy program 
that looks at the country a person was born and applies a cut-over date that is appropriate 
to that country. Now that is a challenge for the developers.
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Double date format
Double Date Format warns you of the possibility of a date that falls into a special category. 
The following table describes the options available:

Options Description

Leave this date 
as it is

Does not change the date you entered in the Date field.

Use double date 
formatting

Changes the date to the double date format, and shows an example of how it 
will be entered in the Date field.

Always use this 
setting

Makes your selection the default for future double dates. The Double Date 
Format dialogue box will not open again to alert you of a double date. To reset 
the dialogue box to open again, click Tools > Options
>Warnings >then select Prompt me from the Double Dates drop-down menu.

If you look at Family Tree Maker help you will see the following.
Beginning in 45 B.C., many parts of the world used the Julian calendar to mark the 

passage of time. According to the Julian calendar, March 25 was the first day of the year 
and each year was 365 days and 6 hours long. In 1582, Pope Gregory XIII determined that 
the Julian calendar was incorrect: each day was just a little bit too long. This meant that the 
human calendar wasn’t keeping up with nature’s calendar, and the seasons kept arriving 
slightly earlier in the year. To solve the problem, Pope Gregory XIII created the Gregorian 
calendar.

This is the calendar that used officially in the UK, Australia, New Zealand, Canada, the 
US and many other English speaking countries. This new calendar changed the first day of 
the year from March 25 to January 1. Pope Gregory also had everyone jump ahead by 10 
days to make up for the days that were lost when the world was using the old Julian calendar.

The practice of writing double dates resulted from this switch from the Julian to the 
Gregorian calendar, and also from the fact that not all countries and people accepted the 
new calendar at the same time. For example, England and the American colonies didn’t 
officially accept the new calendar until 1752. Before 1752, the English government still 
observed March 25 as the first of the year, but most of the population observed January 1 
as the first of the year.

For this reason, many people wrote dates falling between January 1 and March 25 with 
both years, as in the following examples.

Julian or Old Style Gregorian or New Style Double Date

25 December 1718 25 December 1718 25 December 1718

1 January 1718 1 January 1719 1 January 1718/19

2 February 2 2 February 1719 2 February 1718/19

25 March 1719 25 March 1719 25 March 1719

By the time England and the colonies adopted the new Gregorian calendar, the 
discrepancy between the two calendars was 11 days, instead of 10. To resolve the 
discrepancy, the government ordered that 2 September 1752 be followed by 14 September 
1752. Some people also added 11 days to their birth dates (a fact which is not noted on 
their birth certificates).
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New users to Family Tree Maker occasionally post to an Family Tree Maker help site 
along the lines of ‘Help, every time I add 2 February 1718 I get 2 February 1718/19. What 
have I done wrong?’ The short answer is nothing and welcome to double dates.

Incidentally, in researching this article I put ‘double dates’ into Google and got a lot of 
information not related to calendars. It appears that the term ‘double dates’ can have other 
meanings!

Date entry options
Family Tree Maker lets you set how you want you enter your dates and how you want your 
dates to appear in reports and charts.

The key bit to understand is that Family Tree Maker allows you to enter the date in 
one format, e.g. (say) Month, Day, Year and display it in another format (say) Day, Month 
Year. Normally though most users would have the date options set to be the same. You can 
alter the way dates are handled 
in Tools>Options>Names/Dates/
Places (Win) or Family Tree 
Maker 3>Preferences>Dates/
Names/Places (Mac). It is 
important to get this correct as if 
you entered a date 10 September 
1878 with the date input set at 
DMY, (9/10/1878), it would 
display as 9 October 1878. So 
think through how you want your 
dates to be entered and displayed.

Date Options (Win)

Date Preferences (Mac)
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Displaying dates
Note that you also have options to not only display dates as DMY or MDY but also how 
that date is displayed. Take the example given

5 March (Year). Options

Day: 5, 05, 5., 05.

Month March Mar 3 03

Separator / - ,

Note also that you can have a different input format to the output. So you could enter 
your dates DMY, and have them displayed as MDY in reports etc. For example, if you 
were sending material to someone in the USA. Conversely, if someone sends you a Family 
Tree Maker file or GEDCOM file and after it loads it displays dates as MDY simply 
altering the date display in Options/Preferences and you see it as DMY.

Date formats in various countries
Various countries use varying date formats. Here are some examples:

�� Australia: day month year with slashes as separators e.g. 26/3/1911.
�� Canada: officially uses year month day with hyphens as separators e.g. 1911-3-26.
�� Germany: day month year with full stops as separators e.g. 26.3.1911.
�� UK: uses what is generally considered the ‘European Standard’ day month year 

with slashes as separators 26/3/1911. Written out this date would be 26 March 1911, 
which is the ‘genealogical standard’ for dates.

�� USA: uses month day year with slashes as separators e.g. 3/26/1911. 
�� Family Tree Maker can understand them all.

Date keywords
As well as entering an exact date e.g. 5 March 1832 or 5/3/1832, you have some great 
options to enter dates in a more inexact form. These are called Date Keywords.

Certain keywords can be used in the date field to help define the date. For example, 
you may be uncertain about the birth date of a person but know it falls somewhere in the 
year ‘1900’. In the Date field you can express that by typing ‘Bet. 1900–1901’.

The following table describes the keywords you can use and how Family Tree Maker 
expresses them:

Keyword Result

About, ABT, or A Abt. 12 Dec 2004

AD 68 AD

After or AFT aft. 12 Dec 2004

Ante Bef. 12 Dec 2004

Before, BEF or B Bef. 12 Dec 2004

Between, BET, or BTW . . . and Bet. 9 Dec–12 Dec 2004
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BC 22 BC

Calculated or Cal Cal. 12 Dec. 2004

Child Child

Circa, Cir, or C Abt. 12 Dec 2004

Dead Dead

Deceased Deceased

Estimated or EST Abt. 12 Dec 2004

From . . . to Bet. 9 Dec–12 Dec 2004

Infant Infant

Never Married Never Married

Post Aft. 12 Dec 2004

Stillborn Stillborn

Unknown Unknown

Young Young

? Unknown

Tip
I like the ‘?’ for Unknown. If I have for example a person who I know has died and I don’t 
know the date of death, I type ‘?’ in the Date of Death field and Family Tree Maker shows 
it as ‘Unknown’. So one keystroke gets me a 7-character word and aids my consistency 
and you all know how I love that word!

Y2k
Remember the year 2000 when everyone was worried about how dates in the 19xx format 
(most commonly written xx and that was the problem) were going to work when the 
calendar got to 1 January 2000? Well, Family Tree Maker has always been Y2k compliant. 
When you enter a date you have to put four characters in for the year. 

If you enter 3 March 13, Family Tree Maker does not know if you mean 2013, 1913, 
1813 etc, so it prompts you for a full year input.

Date calculator
If you click at the RH side of any date field or Tools>Date calculator (Win) or (Mac) you 
get a nifty little date calculator that can help you determine various date facts including the 
day that an event occurred; e.g. I know my birth date but what was the day?

Actually, I think the Mac version is a little friendlier, but both work the same way as 
follows:

Date Calculator helps you determine the birth date of a person, the age of a person at the 
time of an event, or the date of an event. You need two of the details to calculate the third. 

For example, imagine you find a tombstone or death record that says: Died March 
15, 1886, Age 52 years 6 months 5 days. What was this person’s birth date? Use the Date 
Calculator to find out.
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The date calculator has the following options:

Option Description

Item to calculate Select which detail you want to calculate. In the Calculate area, the detail 
you select is made inactive so you can’t enter any data. The results of the 
calculation will appear in the inactive field.

Date of known event/
Known birth date

Enter the date of birth or the event. The more precise the entry, the more 
precise the answer will be.

Age at time of event When calculating the Birth date or Other event date, enter the age of the 
person at the time the event took place. The more data you can enter 
here, the more precise the answer will be.
  When calculating Age, the calculated age will be displayed in these 
fields.

Calculated birth date/
Date of calculated 
event

When calculating the Birth date or Other event date, the calculated date is 
displayed in these fields.
  When calculating Age, enter the date when the person was born. The 
more data you can enter here, the more precise the answer will be..

Calculate Determines the third detail according to the other two details entered. The 
answer is displayed in the inactive field.

Clear Removes all of the data currently in the calculator.

Copy Copies the data in the field into the clipboard so you can paste it 
elsewhere in Family Tree Maker or in a different program.

Date Calculator (Win)		          Date Calculator (Mac)

So if you have never used the date calculator I encourage you to try it out.

Date errors
It is inevitable that as you work on a file, you can make unintentional errors when entering 
dates. There are two ways to trap them.

The Tools>Options/Dates (Win) or FTM3>Preferences>Date (Mac). You will see also 
that there is a warnings tab associated with each dialogue.
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Date Error Setting (Win)			         Date Error Settings (Mac)

I recommend that you set the warnings initially to how they are shown, particularly the 
‘Show unlikely birth, death and marriage dates’. Family Tree Maker will warn you if you 
enter a birth date for example where the mother is already deceased.

Options Description

Date display format Lets you specify how dates are displayed in Family Tree Maker and for 
printed reports. The generally accepted format is Day Month Year with a 
three-character month (for example, ‘12 Dec 1931’).

Date input format Lets you specify how you want Family Tree Maker to read your date inputs. 
You can have either the month or the day first.

Name index options Lets you select how names are displayed in the Index of Individuals 
and the Index panel in the People workspace. You can select from the 
following options:
  Use AKA if available as a middle name: If an alias is included in quotes 
after the middle name, both the given name and AKA (Also Known As) 
are listed in the Index.
  Use AKA if available as an additional entry: If an alias or nickname has 
been entered for an individual, both the given name and AKA are listed in 
the Index.
  Use titles if available: If a name includes a title, both the given name 
and title with name are listed in the Index.
  Use married names for females: Lists married females by their married 
name instead of the maiden name.

Double dates Lets you specify the year after which double dates are no longer 
calculated.

Finding date errors
Family Tree maker has an excellent tool for finding errors including date errors. It is the 
Data Errors Report (DER) and it is in the Publish>Person Reports.

I am using just the Mac screen shot on this occasion as the dialogue box is larger and I 
can fit all the potential date errors in. You can find the same date errors in Windows version.

As with all reports of this nature in Family Tree Maker, you can run the report for the 
immediate family of the focus person, all individuals and selected individuals which brings 
the Family Tree Maker filter into play.
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Note: I am planing a companion to this 
book where I will be discussing reports, 
charts, books and online trees in Family Tree 
Maker.

Using the Data Errors Report (DER)
Go to Publish>Person Reports and open 

the DER and click on the errors to include 
button in the RH editing panel, (arrowed 
button with the green arrow) and the Errors To 
Include dialogue opens. I would suggest that 
you don’t tick all the error boxes; otherwise 
you may get a very big report. Rather, select 
(say) the first potential date error, e.g. ‘Birth 
date after the father’s death date’ and select 
‘All individuals’ and run the report.

If you have any suggested errors go and 
examine each one in turn and correct. Repeat 
the process for the next potential error.

The process is repeated until you have fixed all the errors. Note that you can trap other 
potential errors as well as date errors. Your aim is to get a zero return for all errors in you 
file. (I am down to 10 pages in a 7500-person file, so I am nearly there). Wish I could say 
the same about undocumented sources but that is for another day.

Summary
If you get all your dates correct, they of course will show correctly in all reports, charts 
and books and in particular a timeline report will be correct. Happy dating.
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Chapter three
Door number three—the place door

Places fill a key part of family history research. Most of us are keen to discover where 
significant events in the life of our ancestors took place and to record them in a sensible 

and consistent manner. Family Tree Maker has addressed this issue since version 2008 with a 
Place Name Authority that has been significantly updated and linked to Bing Maps, but also 
the program added a Description field to the program that greatly assists in recording place 
data. Finally in a very welcome update the PNA was significantly enhanced with a hierarchy 
view of places. In this chapter, I am going to walk you through how it all works.

The Place Name Authority (PNA) was added to Family Tree Maker 2008 and consists 
of an inbuilt database of places, some three million of them. This allows you to standardise 
your locations to ensure a great deal of consistency, (regular readers will know that is my 
favourite word in Family Tree Maker). Do not confuse the inbuilt PNA and the ability to 
display places in Bing Maps when connected online. The PNA is fully available in Family 
Tree Maker regardless if you are online or not.

The PNA and places in general have been progressively enhanced since being 
introduced in version 2008 and with version 2010 significant enhancements to places and 
general navigation capability were added with further significant updates with version 
2012. So let’s start on our places journey.

Description field
A major defect existed in Family Tree Maker from version 2 through the version 16 which 
was corrected as part of a re-write of Family Tree Maker 2008 and above with the addition 
of a Description field in the locations. If you haven’t turned on the Date/Place/Description 
view, do this.

�� Go to the People>Person view for any person
�� Select (say) the Birth fact
�� In the right hand editing panel click on the Options button
�� Select Fact Properties and click on the Place Description radio button
�� Click OK
Repeat this for other date type facts, e.g. christening, marriage, death and burial. You 

will then find that you have a description field available to you.
The description field is a free-form text field that you can record additional 

information, anything associated with a location, name of a hospital, a street address, 
cemetery location, etc. It also has Family Tree Maker’s fastfield capability which lets you 
be very consistent with description entries. 

If, for example, you are entering (say) a cemetery location in the Burial Description 
field, entering a few of its first letters e.g. Melbourne as part of Melbourne General 
Cemetery, the fastfield will complete the entry. You can turn on the fastfield function in 
Tools>Options or Family Tree Maker 3>Preferences.
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Turning on the Description Field (Win—above)
(Mac—right)

Now the significance of this revision is to suggest that the PNA can be very useful in 
getting your place names both accurate and consistent as well as working with the mapping 
database, MS Bing Earth, (previously MS Virtual Earth).

Now a few comments about the PNA
Firstly you don’t have to use it at all. You can use it for as many or as few places as you 
want. I personally think it is great and I also like the ability in the PNA to remove duplicate 
places with the ‘replace with other place names’. Great when web merging and the merge 
produces different ways to express a place.

When I first looked at the PNA in version 2008, I suggested that I tended to try to 
standardise a more major place (say) Melbourne, Victoria, Australia in the Place field and 
use the Description for the minor place, e.g. a suburb or a church name etc. What I have 
found with the updated PNA, is more minor places are recognised in their own right and 
can go straight into the Place field as they then plot best on the map. So Lilydale, Victoria, 
Australia is now supported by the PNA. So I have tended to use the PNA suggestion if it 
fits and, if not, use the next largest place and add the minor detail in the Description field. 

Also, be aware, especially with historical named places, that the PNA is unlikely to 
recognise the place. In this instance I think it is best to ‘Ignore Place Warning’ in the PNA 
and leave the historical name as is. So, with a bit of care you can make a very good job of 
resolving place names. It is worth the effort to get it right.

Short place names
Now all this is well and good and you end up with highly accurate place name data, but 
the problem is that the full name can be very large, e.g. ‘Kirton-in-Lindsey, Lincolnshire 
England’, or even better, ‘Levin, Horowhenua, Manawatu-Wanganui, New Zealand’. Yes, 
that is straight from the PNA.

If you wish to use these names in (say) a boxed descendant chart, you very quickly use 
up the real estate inside the box. What is needed therefore is the super accurate full place 
name in the database, but the ability to use a ‘short place name’ in a chart or report. Best of 
both worlds. Enter the Short Place Name enhancement in version 2010.
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Short Name and location 
advised

If you go into the Places Workspace for any particular place you see the right hand edit 
panel like the above. Note the new Short place field and also the geographic locator. More 
on that shortly.

Now what you can do is add a short name place and in my example I have used 
Frankfort. Also note the Associated People number. More on that later.

Now, Family Tree Maker can use the short place names in any chart or report. If a 
short place name is not available, it will of course use the full place name. To invoke the 
short place name in any chart or report, in the Publish Workspace, click on Items to Include 
and check the Display user-defined short place name.

Geographic locations
New to Family Tree Maker 2010 was the ability to add a geographic location (latitude 
and longitude) coordinates and have them converted to a place or a location. You may for 
example have a location of an overgrown cemetery or perhaps you have ancestors who 
were on the Titanic and by adding the coordinates Family Tree Maker can plot the location. 
This is great if you have an ‘at sea’ event and have the coordinates. To do this, simply add 
the coordinates in the location field. There are three ways to add coordinates and Family 
Tree Maker has a new Location Calculator.

The Location Calculator converts the latitude and longitude coordinates between 
different coordinate styles.

Family Tree Maker displays the coordinates in decimal degrees format.
You can use the calculator to enter the coordinates in degrees, minutes, seconds format 

or degrees and decimal minutes format, and the calculator will display the coordinate in 
decimal degrees. You can also use the calculator to convert any of the formats to another 
format for other purposes you may have.

Location Calculator (Win)	              Location Calculator (Mac)
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The following table describes the options available:

Options Description

Entered Displays the coordinate entered in the Location field.

Degrees minutes
seconds format

Lets you enter or view the coordinates by degrees, minutes, and
seconds. The degrees and minutes must be whole numbers. 
Seconds can be expressed with a decimal. Latitude degrees cannot be 
higher than 89. Longitude degrees cannot be higher than 179. Minutes 
for latitude and longitude cannot exceed 59. Seconds for latitude and 
longitude cannot exceed 59.99.

Degrees and
decimal minutes format

Lets you enter or view the coordinates by degree and minutes.
Degrees must be whole numbers. Minutes can be expressed with a 
decimal. Latitude degrees cannot be higher than 89. Longitude degrees 
cannot be higher than 179. Minutes for latitude and longitude cannot 
exceed 59.999.

Decimal degree format Lets you enter or view the coordinates by degrees. Degrees can be 
expressed with a decimal. Latitude degrees cannot be higher than 
89.9999. Longitude degrees cannot be higher than 179.9999.

Set to Default Resets the location to the coordinates recorded for the place in
the place authority database.
This button appears only when you have set the coordinates for a place 
that Family Tree Maker recognises.

Being more exact with locations
One of the comments about the Places feature in versions 2008 and 2009 is that sometimes 
the location pin was not located correctly and there was no way to correct the error.

This has now been addressed with the ability to use the push pin adjacent to the 
location coordinate field.

�� To set the exact location of a place.
�� From the Places Workspace, make sure Place is selected in the List by drop-down 

list. Select the place for which you want to set the exact location.
Do one of the following:
�� Enter the GPS coordinates in the Location field.
�� Enter the latitude and longitude in the Location field.
�� Click the push pin button, and then on the map, click the location where the place 

should be. You will see a cross hair then the pin will be precisely located.
Coupled with the updated places and corrections, you can now enter locations on a 

map very precisely. Even although the MS Bing map is very good, inevitably there will 
be places missed, misplaced or too small to show up. Now you have the tool to make the 
corrections right down to ‘micro hamlet’ level.

Migration paths
In Family Tree Maker 2009 a new capability was added to the Places Workspace to allow 
you to visualise the migration path of a person. You clicked on the drop down menu in 
Places and selected Person. This produced a path on Bing maps with nodes for significant 
events in your database, e.g. birth, death, etc. Hovering over a node provided node detail.
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Well this was significantly enhanced in Family Tree Maker 2010.What you can now 
do is add additional plots for family members and generations. It is all done through the 
Migration Toolbar.
Places>Person View Migration Path Tools

Looking at the tools from the left

�� The + magnifier lets you centre and zoom on a selected person, the family icon lets 
you include immediate family

�� The pedigree icon lets you include ancestor generations up to four generations
�� The coloured bars allow you to change the line colours. Clicking on the bars brings 

up a colours selection box
�� The final icon is a sort tool that lets you sort your paths in different ways.

Migration path
Also note carefully the name list below the tools. These change as you select 
different people and also depending on what check boxes are ticked what nodes 
appear on the migration path. It should be apparent that you have a lot of options 

and the resultant map can rapidly become crowded!
In part one of this chapter I have focused on the Places, Mapping and Navigation 

enhancements in Family Tree Maker 2010. I have tried to summarise the new features as 
follows:

�� Enhanced PNA
�� Short Place Names
�� GPS support
�� Location Calculator
�� Pin pointing locations
�� Multiple migration paths
�� Associated people
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The places update- revisited- hierarchy listing
In October 2012, one of the major enhancements was the complete overhaul of the 
Places Workspace in Family Tree Maker. The key thing to understand is that this is 
additional new capability in managing and using the Places Workspace within Family Tree 
Maker. There are perhaps two key things to appreciate.

Places flat form view retained
With place hierarchy turned off, the place list performs just as it did in previous versions of 
Family Tree Maker e.g. a flat form view of each place. For example, Melbourne, Victoria, 
Australia. When the hierarchical view is displayed two new buttons then allow you to 
expand or collapse the entire hierarchy.

One of the additional benefits of this hierarchical structure is that you can now view 
all of the people that are associated with a specific place or any place within it.

This is the first major update of a Workspace since Family Tree Maker 2008 was 
released. To understand what is going on and to explain the concepts to be covered shortly, 
journey back to Family Tree Maker version 16 or earlier. The program only had one field 
to record place data. When maps came into Family Tree Maker (version 7), the developers 
at the time took a short cut and added a slash delimiter to make the rudimentary maps 
function introduced in version 7 (and maintained through to version 16), work. What they 
wanted you to do when adding place detail, was to add it in the format ‘comment/location’. 
Thus you could enter:

‘257 Collins Street / Melbourne, Australia’
The bit before the slash was treated as a comment and the bit after the slash was treated 

as a location and plotted to the map feature and the Maps Legend report.
When Family Tree Maker was rewritten and appeared initially as version 2008, the 

new developers at Provo Utah added an optional Description field to every fact in Family 
Tree Maker. This new Description field was particularly useful for place information as 
you could add a place name in the place field and an expansion in the Description field. 
This may be a street address, hospital name, church, etc.

If you did not use the slash delimiter correctly, when you first came to use version 
2008 or later, you found all your comments mixed up with places and you had to go 
through a once-off resolve place names exercise. As well as resolving places, you had to 
move all the comments into Description fields.

To turn on the description field
Let us say you want to turn on the 
description field for the Birth Date 
event.

Birth Fact Properties
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Go to the Birth Date event in the People>Person view and select it. Now in the right 
hand editing panel click on Options>Fact Properties and check the Date/Place/Description 
radio button. Repeat for other facts that you also want to display the description field. I 
usually have the description Birth, Christening, Marriage, Death and Burial facts. Note 
you only have to activate the Description field once per fact type. You can add details like 
Church, Hospital, Street address, Cemetery etc. in the description field.

The Hierarchical View for Places. What is a Hierarchical View?
This is a way of listing places in a cascading form e.g.
Country>State>City
This allows grouping of locations which will become apparent over the next page or so.
Flat vs. Hierarchical Display of Place Names

Places Flat Form view			   Places Hierarchical view

The header above the place name index now includes a new 
option for switching between the traditional flat view of place 
names, and a new hierarchical view. The new hierarchical view 
is on by default, but you can switch to the flat view by clicking 
the ‘Turn off place hierarchy’ button.

With place hierarchy turned off, the place list performs just 
as it did in previous versions of Family Tree Maker.

Now if I have towns or villages in my county, we can go down another level. So in this 
example I have gone England>County>Town>Village e.g.

England>Lincolnshire>Kirton-in-Lindsey>Village e.g. North Kelsey
If you happen to have any additional place detail within the city/town, (such as a 

church, cemetery, address), that information could be shown by expanding the detail under 
the city or in the description field. 

This can be done because of a change, which allows place detail to be excluded when 
resolving place names. This is a brilliant way to group locations without having to do way 
with seeing the full flat form location as well.
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Showing three descending views of a Hierarchy list—Country to Village. Clicking 
on the twistie icon reveals the next level down. This is the real benefit of the hierarchical 
view.
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Viewing associated people
One of the additional benefits of this hierarchical structure is that you can now view all of 
the people that are associated with a specific place or any place within it. In the example 
below, Kirton-in-Lindsey, Lincolnshire, England is selected in the place index and there 
are 299 people listed in the right panel who are specifically linked to this place.

Notice the two new options above the list of people: ‘Linked to This’ and ‘Linked to All’.

The Linked to This option
This option shows only those people who are linked specifically to 
Kirton-in-Lindsey as an end point.

Linked to all
The ‘Linked to All’ option shows all the people linked to Kirton-
in-Lindsey and all localities within it. With this option selected the 
right panel displays the people linked to Kirton-in-Lindsey and those 
linked to places within it (say) churches.

When the list of people’s facts is expanded, each fact that is 
associated with the place specifically is marked with a red pin. 

The other facts are associated with a locality within the 
selected place.

Moving the pin
If a place is not exactly located on the map with the pin, you 
can move the pin simply by right clicking on the pin icon at the 
right of the location window—the pin changes to cross-hairs.

Drag these to where you want them re-located on the map 
and release the left mouse button. The pin will be located as 
you want it.

Place images resolved or unresolved
The new facility has introduced some new icons to denote place states. You need to 
understand what they mean!!!

Denotes and unresolved place name 

Denotes a resolved place name that has people/fact specifically linked to it 

Denotes a resolved place name that does not have people facts linked specifically 
to it

Used to indicate unresolved place details within an otherwise resolved place name
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Resolving place names
The ‘Resolve Place Name’ dialogue has some new options for designating place details. 
The example below shows how the dialogue would look before resolving a place name that 
includes the name of a church. All of the place name information is in the ‘Place name’ 
field and of course there is not direct match in the list of suggest place names. Of course 
there is no problem with leaving the place this way if desired.

‘54th Street, Long Island City, Queens, New York, USA’. This is flagged by Family Tree 
Maker as not recognised by the PNA. I select the place and click on Resolve Place Name.

I look at the first place element ‘54th Street, (the comma is critical) and using the 
I move ‘54th Street’ up one level to the Place detail box. This leaves Long Island, 
Queens etc. in the Place name field which the PNA in Family Tree Maker recognises. So I 
click Replace.

I have now resolved the place and it will list hierarchically if I choose, but I still have 
the full flat form address.

When this option came out in version 2012, I went through my 1540 place names and 
gradually resolved them one by one.

It was quite cathartic as I gradually resolved all my place names (and merging 
duplicates) until I got all my places showing at country view at the highest hierarchy level, 
right down to street detail in some cases at the lowest level view. It took me a weekend but 
it was worth it. Of course you don’t have to resolve all your place names nor do you have 
to do them all at once.

Resolve all place names
Family Tree Maker also has a resolve all place names tool. If you click on the Resolve All 
Place Names button you get a table of unresolved places that you can rapidly resolve.

If you understand how this section works and in 
particular the above dialogue, you have understood 

the core of how to resolve place names.
Just one simple arrow.
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Whilst this appears less work, I still found going through the places one by one and 
subjecting them to the ‘eyeball test’ was at the end more satisfying.

The Resolve All Place Names options are:
Options Description

Unrecognised Place Name Lists each place name that is not found in the Family Tree Maker 
places database. A place name might not be resolved because it is 
misspelled, is entered in an incorrect format, the city no longer exists, 
or the city population is too low.

Suggested Place Name Lists the closest match that Family Tree Maker could find.
To replace the Unrecognised Place Name with the Suggested Place 
Name throughout the tree, select the check box to the left of the 
Suggested Place Name

Desc. Select the Desc. check box to move the Unrecognised Place Name 
from the Place field to the Description field in each fact it appears.
  This is an easy way to move descriptions that were imported into 
the Place field to the Description field.

Ignore This is an easy way to move descriptions that were imported into the 
Place field to the Description field.

Other Select the Ignore check box to have Family Tree Maker remove the 
Unrecognised Place Name from the list and ignore the spelling or 
format in the future. The place name will be removed from the 
Resolve Place Names dialogue box. The place will no longer be 
marked as unrecognised in your tree.
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Historical place names—best ignored
Note that historical place names like the old name for Los Angeles, USA, ‘El Pueblo de 
Nuestra Señora la Reina de los Ángeles de Porciúncula’ are best not resolved but ignored.

Place find function changed operation
The Find Function in Places works differently now. After typing in the find field, press 
Enter or click the ‘Find Next’ button. Because of the hierarchical nature of the list, it will 
search anywhere within the place name. Then to find the next match, press Enter again. 
Because of the way this find works now, the developers opted to not execute the search 
automatically, but wait for the user to press Enter or click.

Find next
Because it can now find matches in the middle of a place name, it seemed that executing 
the search automatically caused too many false positives.

Undocumented feature—place usage report
One change that has been made is to the ‘Place Usage for this Place’ report when run from 
the Places Workspace.

Select Linked to All in the right panel and then Print or Share the report. This should 
give a list of all people and facts associated with a place (directly or indirectly). Selecting 
Canada should give you a list of everyone in Canada and all of the places resolved under 
Canada in the hierarchy.

Merging duplicate places
Often you have a situation where you have one or more places that are the same but have 
been entered slightly differently so they show as additional places. This of course corrupts 
your Linked to This Place list and also the custom report if you are looking for all people 
who had an event at a particular place. My method is to first resolve one place in this case 
New York. Then with the other two ‘New Yorks’ either resolve each or better still use 
Replace with another Place name in this case the resolved New York. Do it one by one and 
you will be rewarded with a very accurate place database plus the hierarchical option.

Summary
You can do many things with Places, especially since the hierarchy feature has been added.

The more that I have played with the new places hierarchy the more that I have come 
to appreciate it. I now have all my places

�� resolved
�� in hierarchical order by countries.
This gives me a very compact place list that can be expanded to whatever level that I 

want to examine.

More information?
Try this Knowledge base article

http://ftm.custhelp.com/app/answers/detail/a_id/5526/kw/places
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Chapter four
Door number four—the sources door

Sources should be an integral part of recording information when using Family Tree 
Maker, as they provide assurance of the accuracy of your data. Sources also let you 

know when and where you obtained your data. Sources also allow anyone reviewing your 
work to form a judgment as to the accuracy or otherwise of your scholarship. Shown Mills 
puts it as the most basic question a genealogist should ask: ‘where did it come from and 
who produced it?’

Theory of sources
Probably the guru of sourcing in terms of family history is Elizabeth Shown Mills in her 
book, Evidence! Citation & analysis for the family historian.

www.amazon.com/Evidence-Citation-Analysis-Family-Historian/dp/0806315431  
It is also available locally from genealogy bookstores.

Book Description—Amazon (124 pages)
Publication Date: January 1, 1997 | ISBN-10: 0806315431 | 
ISBN-13: 978-0806315430 | Edition: Genealogical Publishing Company

Every devoted genealogist is concerned with citations in their analysis for their genealogy. 
Accurate citations are necessary so that the evidence can be judged and if necessary allows 
for the research to be repeated. The author makes it easy to help genealogists (particularly the 
non-expert), to make sense out of citations and to improve their genealogy search. This book 
is considered a genealogy must!

Shown Mills has also published a companion volume Evidence explained: citing 
history sources from artefacts to cyberspace 2nd edition.

www.amazon.com/Evidence-Explained-History-Artifacts-Cyberspace/ 
dp/0806318066

Book Description—Amazon (885 pages)
Publication Date: October 5, 2009 | ISBN-10: 0806318066 |  
ISBN-13: 978-0806318066 | Edition: 2nd

Following its enthusiastic reception in 2007, we are pleased to announce a new edition of 
what is now the definitive guide to the citation and analysis of historical sources, a guide so 
thorough that it leaves nothing to chance, whether you want a podcast or a census record. 
The new second edition of Evidence Explained includes updates to numerous websites, new 
models for electronic sources such as blogs and online forums, and new model citations to 
traditional and non-traditional genealogical sources, thus continuing its role as the single-
most comprehensive style manual for genealogical writing and publishing.

I strongly recommend that you buy a copy of Evidence: citation & analysis for the 
family historian. But I would suggest that you look at Evidence explained in a library.
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Why the focus on Shown Mills?
Why have I focussed on this at the beginning of a Family Tree Maker chapter? Because, 
Family Tree Maker has incorporated Shown Mills’ methods in its handling of sources and 
has also incorporated 170 of her source templates into the program.

So, if you want to get a handle on using sources effectively and consistently in Family 
Tree Maker, you need to understand the theory behind it.

I could of course stop here and get those of you using the Windows version of Family 
Tree Maker to simply go to Help>Training Tutorials and run the animated source tutorial 
complete with its American accent. (They haven’t as yet developed the technology to let 
you select your own voice type preferences like you can with GPS devices).

Users of Family Tree Maker 3 (Mac) don’t get the built in training tutorials for some 
reason, but you can download them from:

www.familytreemaker.com/Learn/Tutorials

Ignore the 2012 after Family Tree Maker, it hasn’t been updated

The Sources Workspace
The Sources Workspace is where you can manage all your sources. There are many views 
and arrangements. Perhaps List By the Source Title (top image) and by Person (lower 
image) are the two that you are most likely to use. As I go through some of the details in 
sources, I would encourage you to occasionally refer back to these views in the Sources 
Workspace.
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List by Source title

List by Person

A few thoughts on sources
I am not going to try and précis Shown Mill’s books, but she starts with a couple of good 
concepts.

Any statement of fact that is not common knowledge must carry its own individual 
statement of source.

Source notes have two purposes:
�� to record the specific location of each piece of 

data
�� to record details that affects the use or evaluation 

of that data
This leads to a consideration of source titles that 

you are going to use in your research. The source title 
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should be sufficiently wide as to allow it to be used multiple times unambiguously, but not 
so general that it is misleading. Let me give you my favourite example. In Australia, the 
recording of births, marriages and deaths is a state government responsibility. So a good 
source title for a birth event could be: State of Victoria, Birth Certificate

This allows me to record birth events for people born in the State of Victoria using as 
a citation the individual details. It is easy to know where one may go and obtain a State of 
Victoria, Birth Certificate.

Now an example of a poor source title may be: Australian Birth Certificate
It is poor source title in my opinion as there is no such thing as an Australian Birth 

Certificate. If you cite a source this way you do not know which Birth, Marriage and Death 
(BDM) office has issued the certificate. It fails the Shown Mills test at the start of this 
article namely; ‘where did it come from and who produced it?’

The point of this is you should consider what source titles you are going to use before 
you start to use them. Fortunately in Family Tree Maker you can rename sources without 
losing any links, but better to think it through first.

My final thought on this is that I wish that I had known about the science of sourcing 
when I started family history, as I know now.

Adding sources in to Family Tree Maker
I am going to cover the basic or classic method then I am going to consider source 
templates. I also should note that Family Tree Maker considers every item as a fact, which 
can be sourced.

So names, dates, places, events, etc., are all facts and you can attach as many sources 
to each fact as you wish. There may be a limit to the number of sources to a fact (maybe 
99 or something like that), but for all practical purpose you won’t find any limits in the 
program.

The classic or (simple) method of adding a source (in 3 steps)

1.	 Click on a field that you want to add a source. The new source citation box is active
If you wish to add a source to a fact in the Person >Fact view, simply click on the new 

Source in the right hand editing panel, or Ctrl+S or Cmd +S (Mac)
2.	 Click on the Add Source Citation. This opens the key source citation dialogue.
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Now this is where the rubber hits the road and where you add your Source title. If you 
have an existing source title you would use the Source title drop down to locate it. If you 
are just starting off you can type in your source title. If it is new Family Tree Maker will 
ask you if this is a new title, or alternatively you can click New and then add it. Now you 
have a lot of very useful options in this dialogue and it is worth understanding them as you 
can make your source very comprehensive.

Option Description

Source title The publication in which the citation is found. This may be a book, volume, 
record, etc.
  You can click New to create a new source or Edit to modify the existing 
source.
  As you type, fastfields displays the matching source names. If you type in 
a new name, Family Tree Maker prompts you to create a new source. You can 
create the new source with only the name or open the Add Source dialogue 
box to define the source.

Repository Lists the repository where the source is housed as defined in the Edit 
Repository dialogue box.

Citation detail The title of the article, page number, Internet address, etc. where the source 
citation text can be found in the source.

Citation text The actual text from the source that pertains to the fact.

Web address The URL of the site where the record is found. Click Go To Web Address to view 
the site in your default Internet browser.

Include in 
reference note

Specifies whether to include the Citation text or Web address (or both) as 
reference notes in charts and reports.

Copy Copies the current source citation, including all of its properties, to the 
clipboard. Copied source citations can be copied or linked to any fact in your 
tree. See To copy and paste a source citation in the Family tab.

This citation is 
linked to X facts

If the citation is associated with any other facts, a note is displayed at the top 
of the dialogue box. Click the link to open the Source Usage dialogue box, 
which lists the facts associated with the source.

View Source Online If the source was found in Ancestry.com and you have access to the Internet, 
you can click this link to view the cited record.

Reference Note 
tab

See Add Source Citation: Reference Note.

Media tab See Add Source Citation: Media.

Notes tab See Add Source Citation: Notes.

All that from one little dialogue!
3.	 Add the information

Congratulations! You have now entered your first source!

Comments
Now we could stop here, and to all the recent new users that I have met at various regional 
and city workshops, this is a good thing to practice in your play file or test file.
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Source templates
Out of Shown Mills came the concept of Source Templates as a means of standardising 
how sources should be recorded in terms of data. As an example, the details you record 
about a book used as a source may well be different from a certificate. By using source 
templates you can capture exactly what you want.

The key bit in all this source template business is knowing what is called the ‘quick 
check’ terms that select the templates to use. For reasons that I have never understood, 
they are not in the program Help nor in the knowledge base. They are in Appendix B of the 
excellent Beyond the basics book, but I obtained Tana’s permission to list them all on the 
GUM downloads page at:

www.vicgum.asn.au	 Public Downloads

Adding a source template
Access the Add Source Citation window. For help, see ‘Adding a Source from the Family 
Tab’ or ‘Adding a Source from the Person Tab’.

1.	 Click New on the Add Source Citation window. The Add Source window opens.
2.	 To choose a template, do one of these options:
3.	 To search for a template, enter a keyword in the Source template field. To narrow 

the list, enter multiple keywords. For example, ‘property’ brings up 11 results, while 
‘property grant’ brings up one result.

4.	 Click a template from the drop-down list that appears. Skip to step 8.
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5.	 To choose a template from a categorised list, click More. The Select Source 
Template window opens. Continue with step 4.

6.	 In Source group, choose the group that most closely matches the item you’re 
sourcing. The categories list changes to reflect the selected source group.

7.	 Choose the appropriate category from the Category drop down list. The templates 
list changes to reflect the selected source group and category.

8.	 Choose a template from the Template drop-down list. A description of the template 
is displayed beneath its title.

9.	 Click OK to return to the Add Source window; the fields that appear now reflect the 
template you’ve chosen.

10.	 Complete these fields as necessary and click OK.
One of my tasks is to convert all my sources to source templates and you can do this as 

follows.

Transferring an existing source to a source template
If you have created your sources using the basic format as described above, and now 
want to use the source templates instead, you don’t have to re-create your sources. Instead 
you can map the fields from the original basic format source to the fields in the desired 
template and transfer the contents over automatically (i.e. no typing).

Click on the Sources Workspace button on the main toolbar
1.	 In the Source groups, double click on the source you want to transfer to a template. 

The Edit Source dialogue opens.
2.	 To find the template you wish to use, enter keywords in the Source Template field 

or click Change to select a template from a categorised list. The change Source 
Type dialogue opens.

Hint from Tana Pedersen: (author of Beyond the basics) ‘I like to drag 
the Change Source Type dialogue so that I can see the Edit Source dialogue. 
That way I can see the original source and don’t have to guess what 
information appears in each field’.

Do one of these options:
�� Select Existing Template to view the fields from the original (basic format) source. 

The drop-down lists contain the template view that you can map.
�� Select New Template to view the fields available in the template. The drop-down 

lists contain the original fields you can map to the new template.
Note: If your original source includes a source repository but the template does not use 

the source repository field, your repository information will be discarded.
You might want to add the repository information to the comments field at the end of 

the template.
For each field do one of these options:
�� Choose discard data from the drop-down list to leave the field blank.
�� Choose a field to move the contents to. You can map multiple fields to one field.
If you can’t decide which field your source information belongs in, map the 

information to the Comments field. You can copy it to a different field later if necessary.
Click OK to return to the Edit Source dialogue. The contents of the original source 

now appears in the template’s fields.
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If you want to use the source templates, I would download the free PDF file, print it 
out and have it handy. There are 170 source templates in Family Tree Maker, which should 
cover most needs although Legacy Family Tree also uses Shown Mills’ methods and 
templates and provides 700 of them!

A mea culpa. One of the jobs that I have set myself is to convert all my sources to 
templates and generally clean them up. I have some 232 sources and 3700 citations and 
they have grown from right back to my Family Tree Maker 2 days and they need some 
urgent renovation.

Managing sources
You can manage your sources from the excellent and often overlooked Edit>Manage 
Sources and the related Edit>Manage Repositories. It is worth having a good look at these 
two excellent tools. One thing you can do is merge duplicate sources. So if you have a 
source, ‘State of Victoria, Birth Certificate’ with various citations attached and another 
‘State of Victoria Birth Certificate’ again with numerous citations attached you can merge 
them and still preserve all the links etc.

Edit Manage Sources	         Edit Manage Repositories

Edit Manage Sources options
Option Description

Find Lets you locate a source in the list by typing words contained in the source 
name. The closest match is highlighted as you type.

Total Sources Lists the number of unique sources found in your tree.

Template name Lists the template used to create source, if a template was used.

Source list entry The list displays sources that are based on a template with an icon .

Sample full 
reference note

Displays how the source text is displayed when used as a reference note in a 
document or book.

New Lets you add a source to the Sources list.

Edit Lets you change the properties of the selected source.

Replace Opens a dialogue box that lets you remove the links to all source citations 
connected to the selected source and link those source citations to a different 
source. The replacement cannot be undone.
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Delete Permanently removes the source from the Sources list. The source citations 
linked to the source will also be deleted. Deleted sources cannot be restored.

Usage Opens a dialogue box that lets you view the facts that reference the current 
source and source citations.

Edit Manage Repositories options
Option Description

New Lets you add a repository to the Repositories list. See Add Repository.

Edit Lets you change the properties of the selected repository. See Edit Repository.

Replace Opens the Replace Repositories dialogue box that lets you remove the links 
to all sources connected to the selected repository and link those sources to a 
different repository.

Delete Permanently removes the repository from the Repositories list. Sources that 
cited that repository will no longer have the linked repository.

Usage Opens Repository Usage dialogue box that lets you view the sources linked to 
the current repository.

Merging files
One of the reasons that I recommend thoroughly examining a donor file 
before merging is to try and get all the sources consistent BEFORE you 
merge!

Rating a source
Obviously there are good sources and not so good sources. And there has been a lot written 
about the subject and a walk through ‘Dr Google’ will give you a lot of reading.

But Family Tree Maker lets you self-rate your sources.

Quality score
Lets you set the quality level you believe is correct for the source. Click the stars to set the 
rating. A higher quality rating has more stars. When you set the rating yourself, the stars 
are blue.

Use standardised ratings
Guides you through the process of rating the source based on 
four criteria: Source, Clarity, Information, and Evidence. As 
you indicate the quality of each criterion, the overall quality 
of the source is displayed as gold stars.
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Adding source citations
Source Citations are the details that distinguish source usage. For example your may have 
a source called ‘State of Victoria, Birth Certificate’ but each certificate differs with the 
citation detail. There are many things that you can do with source citations in Family Tree 
Maker and the following is a compilation of procedures.

Adding a new source citation
1.	 Access the Add Source Citation window
2.	 Complete these fields on the Source tab
3.	 Click OK

Linking a fact to an existing source citation
1.	 Click the People button on the main toolbar.
2.	 Make sure the individual you have entered a fact for is displayed.
3.	 Click the Person tab.
4.	 Click the Facts button (if necessary). The Individual and Shared Facts section 

opens.
5.	 Click the fact you want to add a source citation to in the Individual and Shared 

Facts section.
6.	 On the Sources tab in the editing panel, click the New button and choose Use 

Existing Source-Citation from the drop-down list.
7.	 Click the citation you want to link to from the list.
8.	 Click Link to Citation. The citation information appears on the Sources tab.

Copying and updating a source citation
1.	 Click the People button on the main toolbar.
2.	 Make sure the individual you have entered a fact for is displayed.
3.	 Click the Person tab.
4.	 Click the Facts button (if necessary). The Individual and Shared Facts section 

opens.
5.	 In the Individual and Shared Facts section, click the fact that has the source citation 

you want to copy.
6.	 On the Sources tab in the editing panel, right-click the source citation you want to 

copy and choose Copy from the drop-down list.
7.	 Access the Person tab for the individual you want to copy the source citation to.
8.	 In the Individual and Shared Facts section, click the fact that you want to add the 

source citation to.
9.	 In the editing panel, click the New button on the Sources tab and choose Paste 

Duplicate Source-Citation from the drop-down list.
10.	 In the Sources tab, double-click the source citation you just added. The Edit Source-

Citation window opens.
11.	 Update the source citation as necessary and click OK.
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Formatting a source citation
1.	 Click the Reference Note tab in a source citation. The citation details and citation 

text you have entered for the source citation are displayed.
2.	 To italicise text, highlight the appropriate text and click the Italics button. To 

underline text, highlight the appropriate text and click the Underline button.
3.	 Click OK.

Attaching a media item to a source citation

1.	 Click the Media tab in a source citation.
2.	 Click Attach New Media. The Select Media Item window opens. 
3.	 Locate the media item and click Open.
4.	 Click OK.

Adding a note to a source citation
1.	 Click the Notes tab in a source citation.
2.	 Enter a note. The notes are automatically saved.
3.	 Click OK.

Summary
Sources form a vital part of good family history research and ideally your aim is to have 
every fact that you add to your file sources at least once! The Undocumented Facts in the 
Publish Workspace will in fact produce a list of ‘work to do’. In the companion to this 
book I will be discussing the source reports and also how to incorporate sources in reports 
and charts.
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Chapter five
Door number five—the media door
Media greatly assists in adding interest to your family history story, whether it is family 
photos, historical data/photos from newspapers or books, sound or video clips or maybe 
scans from documents or photos. From the perspective of Family Tree Maker, they 
are all ‘Media’ and that is the term that I will use for the rest of this chapter. Note this 
chapter applies equally to the Windows and the Mac version of Family Tree Maker unless 
otherwise noted.

Organising media
In my view the key to managing media is to effectively organise it. Digital cameras can 
take many shots most of which you will probably never print, but you will likely retain 
many of them. I have found that by organising my media before linking selected ones into 
Family Tree Maker makes a lot of sense.

Why organise your media?
I think that there are four primary reasons why some form of organisation is desirable

1.	 It lets you be more selective
2.	 It lets you pre-edit
3.	 It collates and organises your media
4.	 It gives you control

All of these reasons mean that you should consider some media organisational method.

Software to help your organise your media
In Windows 7 and 8, Windows Live Photo Gallery. 

http://windows.microsoft.com/en-au/windows-live/photo-gallery 
Windows XP has a much simpler media organiser. In the MAC you have the excellent 

iPhoto. Additionally, there are some good free organiser programs around like Google 
Picasa or Irfan Skiljan’s Irfanview. All of these have media organising features and are 
worth looking at.

I still use Photoshop Elements 12 for Windows as my media organiser. I started 
with earlier versions and have simply grown used to how well it works, even although I 
have updated to an iMac, I have not converted to iPhoto, which also has excellent photo 
organising capability. My point is that it really doesn’t matter what organising software 
you use, so long as you use one of them.
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Captions
The key point that I want to stress in all of this is that if you use captions in your media 
organiser to help you categorise your media, these same captions will be transferred as 
EXIF data when you link them into Family Tree Maker. Hence, I use the same caption 
system in both programs. This to me makes a lot of sense.

EXIF—Exchangeable Image File Format
Exchangeable Image File Format (also called metadata) is a specification for an image file 
format used by digital cameras. The specification uses the existing JPEG, TIFF Rev. 6.0, 
and RIFF WAV file formats, with the addition of specific metadata tags. It is not supported 
in JPEG 2000, PNG, or GIF. The EXIF metadata associated with an image and is retained 
in the image file.
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Media Workspace

Media Workspace
You can view your media in different ways via the 
Groups—list by

�� All media
�� Media category
�� Source title
�� Person
�� Immediate family

To add media
There are a number of ways to add media. In the Media 
Workspace, click on Media and then add new media and 
navigate to the media item that you want to add. Then 
you can link the media item to an individual or fact as 
described below. You can also add media from the People 
Workspace in either the Tree or Person>Media view. 
The outcome is identical as the media still ends up in the 
Media Workspace. Note that when you ‘add’ media you 
are in fact linking it to where it resides on your hard drive 
and or the Media Center, which is described further on. 
Family Tree Maker creates the link and also makes a thumbnail image which it can use if 
you lose the media link. If you ‘delete’ media you are actually breaking the link.

As Family Tree Maker is only creating a link, which is not very large, you can add 
(link) as many media items as you like. Further, if you use a media item a number of times, 
all you are doing is making more links. Family Tree Maker is very efficient the way that it 
handles media.
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Media categories in Family Tree Maker
Media categories are an extremely useful tool when linking media into Family Tree Maker. 
By using categories you can organise your media and readily find specific media items.

Family Tree Maker comes with a number of default media categories and you can also 
create your own. When you add media, Family Tree Maker requires you to create at least 
one media category. You can have more if you wish.

Categorised media lets you apply categories to several media items at a single time. 
The following table describes the options available:

Options Description

Media Lists all of the selected media items so you view the categories selected for a single 
media item or for all selected media items.
  When you select a single media item, you can select or clear the selections of the 
categories specifically for that item. You can do that for each item and then save the 
change simultaneously.

Categories Lists the categories that you can assign to the selected media files. The check box 
indicates three possible states of selection for category:  
Indicates that the category is not selected in any of the media files.
Indicates that the category is selected for all of the media files.
Indicates that the category is selected for at least one media item but not all media 
items.

Add Lets you create a new category.

Edit Lets you edit the name of the currently selected category.

Delete Lets you delete the currently selected category.

Clear Removes the selection from all of the category check boxes.

Reset Sets the category check boxes to what they were when you originally opened the 
dialogue box.

Creating media categories
Click the Media button on the main toolbar.

Double-click the image of the media item you want to open, or click the image and 
then click the Detail tab. In the editing panel, click the Edit button. The Categories window 
opens. Do one of these options:

1.	 To create a new category, click Add
2.	 To edit a category, click the category name; then, click Edit
3.	 The Add or Edit Category Name window opens
4.	 Enter a name for the category
5.	 Click OK

When you finish adding and editing your categories, click OK.

BIG TIP.......right clicking on media
One of the most useful tips that I can give about Family Tree maker is 
the support for right clicking. With media this is particularly true and 
as you can see from the adjacent screen shot, a simple right click on a 
media item reveals 19 actions associated with media.
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I have found that over many versions of Family Tree Maker, right clicking is my 
ultimate ‘get out of jail card free’ option. Not only in media, but no matter where you are 
in Family Tree Maker and don’t know what to do next, right click. In most cases right 
clicking reveals all the options available in a particular filed or view. I would encourage 
you to use it often.

Linking a media item to an individual
Media can be linked to an individual. This is how you do it.

1.	 Click the Media button on the main toolbar
2.	 Double-click the image of the media item you want to link to a person, or click the 

image and then click the Detail tab
3.	 Click the Links tab at the bottom of the window (if necessary)
4.	 Click the New button and choose Link to People from the drop-down list
5.	 The Add Media Link window opens
6.	 In the Name column, click the name of the individual you want to link the item to

Do one of these options:
1.	 To link the item to the person, click Link to person only
2.	 To link the item to a specific fact (such as birth or marriage), click Link to person’s 

fact
3.	 Then, click the fact in the list below
4.	 Click OK

Linking a media item to a source

Linking media to a source
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And you can also link media to a source. Do this.
1.	 Click the Media button on the main toolbar
2.	 Double-click the image of the media item you want to link to a source, or click the 

image and then click the Detail tab
3.	 Click the Links tab at the bottom of the window (if necessary)
4.	 Click the New button and choose Link to Sources from the drop-down list

The Find Source-Citation window opens
1.	 Choose one of these options from the View by drop-down list
2.	 Choose All source-citations to view every source citation in your tree
3.	 Choose Source title to group the source citations by their master sources
4.	 Choose Repository to group source citations by the location (such as a courthouse) 

they are found in
5.	 Choose People to view source citations for each individual in your tree

As you choose different source options from the drop-down list, you’ll notice that the 
corresponding groups are displayed.

1.	 Click the appropriate source or individual
2.	 In the Source-citations section, click the source citation you want the media item to 

be linked to
3.	 Click OK

Finding a media item
1.	 Click the Media button on the main toolbar.
2.	 Click the Collection tab (if necessary).

In Groups, choose one of these sorting methods from the List by drop-down list:
1.	 All media. This is the default sort. Every photo, record image, video, and audio file 

in your tree is displayed.
2.	 Media category. Items will be sorted according to the category you assigned them. 

(Because items can be assigned to more than one category, they can appear in 
multiple sorts.)

Source title
Items are sorted according to the sources they are linked to. (Because items may be linked 
to more than one source, they can appear in multiple sorts).

Person
Items are sorted according to the individuals they are linked to. (Because items may be 
linked to many individuals, they can appear multiple times).

Click a category, source, or individual from the list. (A photo icon appears next to each 
group that contains media items.)

The Media Workspace displays every item that matches the sort.

Searching for a specific media item
1.	 Click the Media button on the main toolbar
2.	 Click the Collection tab
3.	 In Groups, choose a sorting method from the List by drop-down list
4.	 Enter the appropriate name or keyword in the Find field
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Find missing media links
Family Tree Maker does two things when you ‘add’ media.

It actually creates a link between the media item and the item you are linking it to. It 
creates a thumbnail of the media item in case you lose the link.

Whilst I recommend letting Family Tree Maker copy your media item to the Media 
Center created by Family Tree Maker for a particular file, sometimes Family Tree Maker 
can lose the link. This can happen for example if you move media to a different folder.

Fortunately there is a routine to search for unlinked media and to try and re-establish 
the link. It is a global command.

The options are:

Options Description

Media Lists the media item in the Media Workspace that have been disconnected from their 
source file.

Path Lists the directory path to the file after it has been found. When the file has not been 
found, you can click the message in this column to open a dialogue box and browse 
for the media item.

Status Indicates whether the file has been found. You can hover the mouse pointer over the 
icon to view the status message for the file.

Attach Lets you select whether to copy the file to the tree’s media folder or link to it from its 
existing location.

Select All Selects each media item in the list to include it in the search. An item is selected 
when a check appears in the box.

Clear All Removes each item from the list so none are included in the search.

Search Initiates the process to locate each selected media file by searching through 
directories on your computer.

The Media Center
(Yes it is spelt that way).

Since version 2008, as I have used Family Tree Maker I have come to the conclusion 
that using the Media Center is a good idea. I noted above that when you ‘add’ media to 
Family Tree Maker you are actually creating a link to the media item on your hard drive. 
Now you have two options.

1.	 You can link directly from the media item to the Family Tree Maker File
2.	 You can allow Family Tree Maker to create a Media Center for the file and link 

from there
Effectively, the Media Center is just another folder that Family Tree Maker creates. 

Then when you link, Family Tree Maker makes a copy of the media item into the Media 
Center and links from there.

Now this makes an additional copy of your media item and hence uses more hard drive 
space, but it puts all your media associated with a particular file in the one place, so it is 
easy to find and back up.

Further, if you have multiple files, a Media Center is created for each file. And of 
course, if you restore from a Family Tree Maker backup file (.FTMB) created by doing a 
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File>Backup from Family Tree Maker and the file contains media, a Media Center will 
be created. Finally if you have missing media links the global find described above will 
probably work better if it finds all the missing links in the one place.

So for a number of reasons, I now use the Media Center for linking to my files. The 
options are:

Options Description

Copy this file to the 
media folder for 
this tree and link to 
it there

Use this option when you want to keep all of your media files together in 
one folder. Family Tree Maker copies the file to the media folder assigned 
to the tree (usually located within the Family Tree Maker folder that is in 
My Documents). This is your best option when the media is located on a 
removable drive, such as a CD-ROM, DVD, or flash memory drive.

Link to this file  
where it is 
(without copying it)

Use this option when you want to save storage space on your computer or 
don’t want multiple copies of a file on your  computer.

Categories Lets you select one or more categories to apply to the media files that you are 
adding to your tree file.
Note: To select None, clear the check mark from all of the category check 
boxes.

Edit Opens the Categories dialogue box so you can add, remove, or edit categories 
in the list.

Always use this 
selection without 
prompting me

This option lets you bypass the Copy To Media Folder dialogue box in the 
future. Every time you add a new media file, Family Tree Maker will use the 
Copy or Link option and assign the categories you have selected without 
opening the Copy To Media Folder dialogue box.
To change the Copy/Link option or to be prompted again, click Tools > Options 
> Warnings, then select the option you want from the Copy media files to 
media folder drop-down menu.

You can also set your link preferences once for a file and Family Tree Maker will use 
this preference every time you add media, ‘Always use this selection without prompting 
me’. You can of course change it if you wish.

Other things to do with media
If you click on the Media Menu button you will see that there are a lot of additional things 
that you can do with Media in Family Tree Maker.

Most of these are fairly obvious and don’t really need further explanation, however a 
couple are more complex which I will cover.

Create a new Smart Story
This capability lets you capture various facts in your database for inclusion in a book. The 
dialogue allows you to create a new Smart Story from a blank page but the more useful 
option is to auto-populate the smart story with facts already in your file. (Text Wrapping)

Create Smart Story prompts you to specify how you want to begin creating a new 
Smart Story. A Smart Story is a description of the life of an individual from your tree. You 
can use facts, media, and sources to help you build the story. The facts from your tree can 
be inserted so the narrative text is already inserted to help you write the story.



page 62  |  Opening the doors to Family Tree Maker

The following table describes the options available:

Options Description

Auto-populate Smart 
Story

This option creates the story using the person facts and relationships 
that have already been entered. Each fact includes text that is entered to 
create sentences that fit the narrative of the story (you can edit the text for 
individual facts in the Fact Properties).
  When the Smart Story opens, you will see the text from the person’s 
record and can add to or edit the text as needed. For more information, see 
Compiling a Story.

Start with a blank 
page

Opens the Smart Story editor without the automatic text from the person’s 
record. You can add facts with prepared text, type your own text, add media 
from the tree or from other sources, and create the story in other ways. 

Always use this 
selection without 
prompting me

Specifies that whichever selection you make this time will be used in the 
future without opening this dialogue box.
  Note: To reset this option to open the dialogue box for future Smart 
Stories, click Tools > Options, then choose Prompt me from Auto-populate 
Smart Stories.

The following can be added to a Smart Story.

Facts
Lists the facts that have been entered for the selected person. The facts that are displayed 
depend on the option selected in the drop-down list. You have these options:

Option Description

Personal Biography Compiles all of the facts for the person into a short 
biography beginning from birth to death. You can drag 
the biography to insert it into the text.

Notes Lists the notes that have been included for the person. 
Each note is listed separately. You can drag any note to 
the Text Item to insert it into the text.

Facts Lists each fact entered for the selected person. When 
you click a fact, Family Tree Maker lists different formats 
of the fact information that you can drag into the Text 
Item.

Fact Sources Lists the facts for the selected person. When you select 
a fact, all sources for the fact are listed in a drop-down 
list at the bottom of the pane. Select a source to view 
the citation text. You can drag the citation text to the 
Text Item to insert it into the text.

Insert Copies the currently selected text field to the Text Item 
at the insertion point.

Media
Lists the image files that are attached to the selected person.
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Important
The performance of the book editor is affected by the memory size of the images and 
charts you include in the Smart Story, the number of media items and charts you include, 
and the memory capacity of your computer. As you prepare images and charts for a Smart 
Story, save colour image files at a resolution of 200 dots per inch (dpi) or less with a 
physical size of less than 8 inches by 10 inches. 

Grayscale or black and white images should not exceed 300 dpi. This provides crisp 
images with smaller memory sizes. When the memory requirements of the book exceed the 
capabilities of your computer, your book may not display or print correctly.

You have these options:

The magnifier
This was added to Family Tree Maker 2012 and has carried over into version 2014 but 
unfortunately has not made it yet into Family Tree Maker 3. It can be invoked on any 
media item in the Detail view of media workspace by simply clicking on the magnifier 
icon

PDF viewer
This very useful tool (2012/14 only) lets you view a PDF file inside Family Tree Maker 
and also if you wish incorporate the magnifier. Note in the first screen shot you see the first 
page of the PDF document not a PDF icon. 

Double clicking opens it in the detail view where you can navigate each page. The 
arrow is point to the pages control being the usual forward and back arrows.

A wish
I wish that the PDF viewer (and magnifier) makes it into FTM 3 or FTM 4.

If you have a PDF media item in FTM 3, double clicking opens your PDF viewer, e.g. 
Adobe Reader, or whatever is your nominated PDF viewer.
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FTM 2014 PDF in Collection view

FTM 2014 PDF in Detail view
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Chapter six
Door number six—the notes door

Why notes?
Notes have the ability to add detail to your research, whether they be in the way of stories 
or biographical Person notes, Research notes, Fact notes, Relationship notes, Source 
Citation notes and Media notes. As you can see Family Tree Maker has many note options 
and they all have a role and all add to your research.

Notes can vary from a brief one-sentence description to lengthy analysis of a source to 
significant biographical details.

Notes can of course be included in reports and Smart Stories. (Smart Stories Windows 
version only).

Types of notes—person notes
Person notes are probably the most common form of notes in Family Tree Maker. They can 
be added in the Tree view, Person view and also during Web Clipping.

Adding person notes to Family Tree Maker

From the Tree view
1.	 Select the person that you want to add a note
2.	 Click on the People>Tree view
3.	 Click on the Notes tab in the right hand editing panel.
4.	 Type in your notes

From the Person view
1.	 Select the person that you want to add a 

note
2.	 Click on the People>Person view
3.	 Click on the Notes tab
4.	 Type in your note

Notes toolbar
One of the most useful things 
in Notes is the ability to format 
your notes by the Notes toolbar.
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You can make all or some of your notes bold, italic or underlined exactly as you can in 
a word processor like MS Word. You can also add bullet points and also add ‘international 
characters’, as Family Tree Maker calls them.

You can also colour the note text as well as spell checking. You cannot adjust the 
typeface or font size. Those are determined when you prepare a report to print. Finally you 
can print a note.

Copy and pasting into notes
You can copy and paste into Notes from another application such as MS Word.

Open MS Word, select your text and copy it. I use the left and right mouse keys to do 
this, but there are other methods.

Now go to the Note in Family Tree Maker that you want to paste the text into.
Again using the mouse, left click in the Notes field where you want to paste your note 

then right click>paste.

Copy and pasting tables
Now, normally I make a comment along the lines, ‘that a feature in the Windows version 
is not in the Mac version’, but in the case of copying and pasting tables, the reverse is the 
case. Consider this simple Chronology table.

1892 Arrived Australia, 5 February

1892–98 Beaudesert

1901–1909 Wellshot Station near Isisford

1908 Calboolture

1928 James died

But if I paste this into Notes in Family Tree Maker 2014 Win (or any other Win 
version), I get this displayed as one line:

1892 Arrived Australia,5 February1892–98Beaudesert1901–1909 Wellshot Station 
near Isisford1908Calboolture1928James died.

The table formatting is lost !!!
If on the other hand if I paste it into Notes in Family Tree Maker 3, I get the table exactly 

as it was set out in MS Word. Further, the table structure is preserved in reports and charts.
I understand that table formatting was deliberately removed from the Windows 

versions, which is a pity, as it seems to work perfectly well in the Mac versions. I would 
like to see table support included in future Win versions.

Where can you use person notes?
Person Notes can be included in Ahnentafels, Descendant reports, Family Group Sheets, 
Individual Reports and Custom Reports as well as Smart Stories (Win version only).

Privatising notes
You can privatise any note by simply clicking on the padlock icon in the Notes 
toolbar. Then you can choose whether or not to include it in reports or when you 
export your tree.
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Research notes
Research Notes can be used to remind you of next steps. These notes can be quite 
detailed and include dates and dot points etc. Russ Worthington in his blog has a good 
commentated short video on how he uses Notes.

http://ftmuser.blogspot.com.au/2014/06/ftm2014-barefoot-genealogist-view-on.
html#uds-search-results

Where can you use research notes?
Research Notes can be included in Ahnentafels, Descendant reports, Family Group Sheets, 
Individual Reports and Custom Reports as well as Smart Stories (Win version only).

To enter a Research Note, go to the individual’s Person tab in the People workspace. 
Click on the Notes tab at the bottom of the window and click on the

Research Note icon.
All the formatting in Person Notes is also available in Research Notes.

Fact notes
Fact Notes allow you to make specific notes about important information that you don’t 
want to ‘get lost’ in a long Person note. In this example I have noted under an Occupation 
Fact, some specific information about the individual’s occupation.

To enter a Fact Note, go to the individual’s person tab on the People Workspace. Click 
on the Facts button and select the Fact you want. In the editing panel on the right hand side 
of the window click the Notes tab.

Enter text or copy and paste from another application.

Where can you use fact notes?
Fact Notes can be included in Ahnentafels, Descendant reports, Family Group Sheets, 
Individual Reports and Custom Reports as well as Smart Stories (Win version only).

Relationship notes
Useful for recording conflicting information about marriage dates, spouses and all that 
sometimes-confusing information, especially multiple marriages and remarrying, etc.

Go to the individual’s Person tab in the People Workspace, click on the Relationships 
tab and click the spouse entry.

Where can you use relationship notes?
Relationship Notes can be included in Ahnentafels, Descendant reports, Family Group 
Sheets, Individual Reports and Custom Reports as well as Smart Stories (Win version only).

Source citation notes and media notes
Again, an under used feature in Family Tree Maker. Whilst the media items do have a 
description field sometimes you need more space to describe the media. You may have 
background information about an old photograph or where it was taken for example. To 
enter a Media note go to the Media Workspace, double click on the Media item you want 
to add a note to and click on the Notes tab.
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To delete a note
To Delete a note simply select all the text by pressing Ctrl+A (Win) or Command + A 
(Mac). Then press Delete or Backspace key.

Putting sources into notes
I have seen a number of Family Tree Maker users putting their sources into Person Notes. 
Whilst this may well capture the source detail, it effectively denies the user the excellent 
source features in Family Tree Maker like the:

�� 170 Source Templates
�� Source Bibliography Report
�� Source Usage Report
�� Documented Facts Report
�� Undocumented Facts Reports

I would strongly urge people to not do this as it reduces or eliminates the excellent 
utility of source features in Family Tree Maker. It is ‘sources for courses’. Notes go in 
Notes and Sources go in Sources.

Notes report
The Notes report was significantly improved in Family Tree Maker 2012. (I described it as 
‘an almost new report’ when I first reviewed it).

It has the ability to show:
�� Private Notes
�� Person Notes
�� Fact Notes
�� Relationship Notes
�� Research Notes

As with all Family Tree Maker reports, you can include the immediate family of the 
focus individual, the extended family, all individuals or selected individuals (which of 
course invokes the Family Tree Maker filter).

Notes online
I have mentioned in other places when reviewing Family Tree Maker 2014 and Family 
Tree Maker 3 that putting your tree online in the free Ancestry Member Tree (AMT) has a 
big advantage as virtually all your tree is now online and forms an excellent Cloud backup. 
This applies even if you never want to share your tree. As you can also link and sync your 
desktop and online trees, you always have a very good online backup.

I have said also that whilst you have backed up your tree online to your AMT, you 
cannot see all the information online.
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So how are notes handled by the AMT?
There are three options:

1.	 Synced Person Notes are visible to the tree owner (you) and any editor role you 
create/invite

2.	 Synced Research Notes are on the AMT but are not visible
3.	 Fact/Media/Relationship/Source Citation Notes are synced with the AMT but are 

not visible

So, another very good reason to use the free AMT facilities, even if you never plan to 
share your tree. If something goes wrong on your desktop, you have an online backup.

An Ancestry.com YouTube on notes
Crista Cowan, the Barefoot Genealogist, has a 26-minute video on Notes on this link:

http://ftmuser.blogspot.com.au/2014/06/ftm2014-barefoot-genealogist-view-on.
html#uds-search-results

Summary
I encourage you to explore the comprehensive Notes features in Family Tree Maker. Using 
notes creatively can richly improve your research not only for your own use, but if you 
share data with other researchers.
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Chapter seven
Final thoughts

I have used Family Tree Maker in its many guises for over 20 years and have often said 
it is the most addictive, intuitive and fun program that I have ever used. Over the years 

it has developed and matured and has taken advantage of confluence of the computer, the 
Internet, online databases and related developments.

In this little Opening the doors book, I have tried to guide you to a number of the 
program’s many features and how and where you should enter data. My aim has been to 
get you started in a way that you are not overwhelmed. I would encourage you to play with 
the program. 

One of the suggestions that I often make to Family Tree Maker user groups and 
workshops that I run is to make a dummy file and practice new ideas with it before 
committing yourself to your main file. Bit like a golfer having a few practice swings. You 
can simply make up some names and dates or use a copy of a backup file, but being able to 
practice ‘in the sandbox’ is a great way to gain confidence. I have explained this in chapter 
1.

You will also benefit by joining a genealogy group that has expertise in Family Tree 
Maker. I am the past Secretary of Victorian GUM Inc. based in Melbourne.  
www.vicgum.asn.au. See page 71. 

GUM was formed by enthusiasts in 1984 just to help folk use and enjoy their 
computers and genealogy software. You might consider joining fellow users in GUM.

There are also numerous other local family history groups scattered around Australia 
and New Zealand and a search online can quickly find them. Join one and I guarantee you 
will enjoy it and learn a lot faster.

But nothing beats a bit of practice and encouragement and support of fellow users. 
FTM is the most popular genealogy software program in Australia and probably the 
western world and there is a lot of support out there.



71

VicGUM® was founded in 1984 by a group of far-sighted 
persons who could see advantages to genealogy recording 
by means of the new personal computers then becoming 
available.

VicGUM® exists to provide technical support and assistance to members. This 
technical assistance is provided by those members in the group who have the available 
expertise. Members have shown that they are willing to share their knowledge and 
expertise to benefit all members.

This technical expertise is not restricted to genealogy programs, but also includes 
related equipment such as computers, scanners and digital photography.

Members also receive the monthly Newsletter by e-mail. This contains a wide range 
of information including many articles about using the more popular genealogy computer 
programs and related technical issues.

Support is also provided by eight Self-Help User Groups. These groups have informal 
monthly meetings to provide assistance with the more popular genealogy programs and 
publishing. Each group is facilitated by a person experienced in the particular program. 
Details of meeting dates and locations are included on the website and in the Newsletter.

Another important method of assistance is the e-mail discussion group, GUMNET. 
This network is available to members only to obtain suggested solutions for technical 
problems. Using this resource the expertise of our membership is freely available to all.

VicGUM® holds monthly meetings at which technical issues are presented to the 
members. In addition, there are a number of full day workshops covering software and 
technical equipment in detail.

More information can be found on our website at www.vicgum.asn.au. On this 
website is all the information needed about participating in the various meetings 
and workshops which are held by the Association. It is also possible to download a 
membership application form. This web site has recently been rewritten and now includes 
a members’ only section where members can download previous newsletters back to 2005 
as well as enjoying 10% discount on the Recommended Retail Price of all software.

John Donaldson, the author of this publication is a Life Member of VicGUM® as well 
as being the GUM newsletter editor and former Secretary.

Doug Elms
President of Victorian GUM Inc 
president@vicgum.asn.au 
www.vicgum.asn.au
http://www.facebook.com/VicGUM
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More Unlock the Past guide books
So you are totally new to Family Tree Maker
by John Donaldson
Family Tree Maker, usually called FTM, is Australia’s 
largest selling genealogy program. It has enjoyed huge 
success and is now in its 22nd iteration as FTM 2014. 
In December 2013 Ancestry.com announced Family 
Tree Maker Mac 3 which was released in Australia in 
March 2014.

This book is intended to be the first of a series about 
Family Tree Maker, and covers the absolute basics that 
new users, with very little computer understanding can 
use to get up and running.

The book takes new users through installation, 
registration, activating an Ancestry.com subscription, 
followed by an introduction to creating or importing 
files. It then introduces the eight workspaces within the 
program with enough simple explanation to start using it.

Extensive use is made of screen shots to assist the user to understand what he or she is 
seeing on the screen.

500 best genealogy & family history tips
by Thomas MacEntee
500 best genealogy & family history tips could best be 
described as a ‘brain dump’ of me, Thomas MacEntee, 
and my many years of knowledge about genealogy and 
family history. Basically what I’ve done is to extract 
my favourite tips and tricks from over 85 presentations, 
10 books and numerous articles. In addition, I’ve 
reviewed the social media posts and conversations from 
Facebook, Twitter and other platforms to highlight 
those issues most important to today’s genealogists. 

What will you find in this ‘best tips’ guide? 
Everything from practical ways to use Google, advice 
on protecting your privacy online, information about 
secret or little known resources for genealogy research, 
and more. The best way to use this guide is to browse 
the table of contents to find a topic of interest. Also simply search the book when trying 
to find a solution to a problem, such as how to cite a source or locate an app to generate 
bibliographic information.

I hope you enjoy 500 best genealogy & family history tips and put it to good use in the 
coming year.

These and other Unlock the Past guide books are available in print and ebook editions from
www.gould.com.au and other resellers              www.gen-ebooks.com
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More Unlock the Past guide books
Evernote for family historians
by Carole Riley
Family historians have more need than most people to 
be organised. We have a lot of electronic and paper files 
in different places in different formats. Evernote can 
collect everything together, all in one place:

•	 	digitised images and digital photographs
•	 	scanned documents 
•	 	research notes and database printouts
•	 	PDFs and eBooks
•	 web pages and links emails
•	 	voice recordings and family videos

We can organise all of this treasure, access it quickly 
and easily, and synchronise it between our computers, 
phones and tablets. We can search across and within 
many files at once, even PDFs, handwriting and audio 
files. We can share with others and collaborate on projects.

Evernote can change the way we go about our research and can reduce the need for 
printing and hardcopy storage. We can also use Evernote to organise other areas of our 
lives – writing, travelling, shopping, finances, technology – the possibilities are limitless.

Evernote can change your life. This book will show you how.

Researching in German civil and church records 
by Eric Kopittke
This book answers the question ‘How can I obtain a 
birth or marriage certificate from Germany for an 
immigrant ancestor?’ In Germany the system of 
registration of births, marriages and deaths by civil 
authorities, and the issue of associated certificates, 
has some significant differences to the system that the 
researcher may be used to.

Prior to the introduction of civil registration, 
churches kept registers of baptisms, marriages and 
burials, and such church records may allow researchers 
to follow the family back for several hundred years. 

This practical guide, aided by many illustrations, 
will allow the reader to become familiar with the types 
of information available on German civil certificates 
of birth, marriage and death and church records of baptism, marriage and burial. The 
book then explains how to access these records and builds on the information given in the 
companion volume Locating your German ancestor’s place of origin.

These and other Unlock the Past guide books are available in print and ebook editions from
www.gould.com.au and other resellers              www.gen-ebooks.com
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More Unlock the Past guide books
Arrivals in Australia from 1788
by Kerry Farmer
This book introduces the history and records of 
migration to Australia from 1788.

Migrating to a new country was one of the most 
dramatic life changes anyone undertook and it certainly 
affected the lives of their descendants. Investigating 
their journey is a key part of your family history 
research. 

However immigration records in Australia are 
not all held in one place – when, where and how they 
arrived affect where (and whether) records of their 
arrival can be found. Understanding categories of 
arrivals and the immigration schemes in place as well 
as the general principles of where documents are held, 
will give you confidence that you have looked in all the 
right places

Down and out in Scotland
by Chris Paton
It is one of greatest truisms of family history research 
that we will often find that the lives of our ancestors 
were best documented when the chips were truly down.

There were many battles that our forebears fought 
for and against, both on a personal level and a part of 
the society within which they lived. There were the 
laws of the local parish church and the punishments 
awaiting those who breached kirk discipline; the 
struggles to avoid poverty and the stigma of being a 
debtor; the darkest moments of the soul, from mental 
health issues and illness, to murder and suicide; and 
the dramatic moments of rebellion, when our forebears 
drew a line in the sand against a perceived tyranny or 
democratic deficit. Illness, death, bigamy, abandonment, 
accidents, eviction, ethnic cleansing - a dramatic range of challenges across a lifetime, and 
at times, outright tragedy. And close to each of them, a quill and ink.

But through all of these episodes, there is an even greater story that emerges, of 
how our ancestors overcame such struggles. This guide helps us to truly understand the 
situations that our ancestors had to endure and overcome across the generations, to hep us 
become the very people who we are today.

These and other Unlock the Past guide books are available in print and ebook editions from
www.gould.com.au and other resellers              www.gen-ebooks.com
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Australia, New Zealand and beyond. It is a collaborative venture involving 
a team of  expert speakers, writers, organisations and commercial partners 
throughout Australia, New Zealand and overseas.

What is Unlock the Past?
•	 �a major events resource - supporting existing events and running major events of  our own
•	 a publisher of  important guide books
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John Donaldson started using Family Tree Maker when it was released as a two 
floppy disk program for Windows 3.1 in 1994. Since then he has used all the 
versions, and now uses both Family Tree Maker 2014 for Windows and Family 
Tree Maker for Mac 3.
  In 1996 he applied to beta test the program, when Brøderbund Software 
in San Francisco was producing it. The program has gone through a number 
of  owners and is currently owned by Ancestry.com, John has continued to be 

involved in beta testing, and has participated in some 17 consecutive releases.
  In March 1998 he commenced writing a series of  Family Tree Maker columns for 
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GUMNET, GUM’s members only message board. In 2014 through GUM John was one of  the key 
organisers and speakers at the very successful “Duff  Downunder” seminars with Mr Duff  Wilson, 
Senior Product Manager Family Tree Maker at Ancestry.com in Brisbane, Sydney and Melbourne.
  John’s comment about Family Tree Maker is that it is ‘the most addictive, intuitive and FUN 
program that he has ever used.
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Family Tree Maker, usually called FTM, is Australia’s 
largest selling genealogy program. It has enjoyed huge 
success and is now in its 22nd iteration as FTM 2014 
for Windows and Family Tree Maker 3 for Mac. Both 
versions run on the same database and the files are 
interchangeable.
  The book takes users through the various data entry 
‘doors’ in Family Tree Maker encouraging them to focus 
on correct data entry so that the program can deliver 
the best outcome and output to the user.
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